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PREFACE 

Conventions and Symbols 

The following symbols may appear in this manual and may be applied to the equipment. The reader 
should become familiar with the symbols and their meaning. Symbols are provided to quickly alert the 
user to safety related situations, issues, and text. 

 
Symbol Meaning 

DANGER

 

Indicates an immediate hazardous situation which, if not avoided, will result in 
death or serious injury. 

WARNING
 

Indicates a potentially hazardous situation which, if not avoided, could result 
in death or serious injury. 

CAUTION
 

Indicates a potentially hazardous situation which, if not avoided, may result in 
minor or moderate injury. 

CAUTION
 

Indicates a potentially hazardous situation which, if not avoided, may result in 
property damage. 

NOTICE
 

Indicates a potential situation which, if not avoided, may result in an 
undesirable result or state. 

Important Identifies an action that should be taken to avoid an undesirable result or state. 
Note Identifies additional information that should be read. 

 

Electrical shock hazard. The included Warning text states that the danger of 
electrical shock is present. 

 

Electrical shock hazard. Indicated that the danger of electrical shock is 
present. 

 

Explosion hazard. Indicates that the danger of an explosion hazard exists. 

 

Electrostatic discharge. The presence of this symbol indicates that 
electrostatic discharge can damage the electronic assembly. 
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Qualified Persons 

The described equipment should be installed, configured, operated, and serviced only by qualified persons 
thoroughly familiar with this publication. The current version, in Portable Document Format (PDF), is 
available at http://sitescape.sea.siemens.com/. 

For the purpose of this publication and product labels, a qualified person is one who is familiar with the 
installation, construction, and operation of the equipment, and the involved hazards. In addition, he or she 
has the following qualifications: 

• Is trained and authorized to energize, de-energize, clear, ground and tag circuits and equipment in 
accordance with established safety practices. 

• Is trained in the proper care and use of protective equipment such as rubber gloves, hard hat, safety 
glasses or face shields, flash clothing, etc., in accordance with established safety practices. 

• Is trained in rendering first aid. 

Scope 

This publication does not purport to cover all details or variations in equipment, nor to provide for every 
possible contingency to be met in connection with installation, operation, or maintenance. Should further 
information be desired or should particular problems arise which are not covered sufficiently for the 
purchaser’s purposes, the matter should be referred to one of the support groups listed in the Product 
Support section of this manual. 

The contents of this manual shall not become part of or modify any prior or existing agreement, 
commitment or relationship. The sales contract contains the entire obligation of Siemens. The warranty 
contained in the contract between the parties is the sole warranty of Siemens. Any statements continued 
herein do not create new warranties or modify the existing warranty. 

General Warnings and Cautions 

WARNING
 

This equipment contains hazardous voltages, and it has been certified for use in the hazardous locations 
specified on the product nameplate and in the Model Designation and Specifications section. Death, 
serious personal injury, or property damage can result if safety instructions are not followed. Only 
qualified personnel should work on or around this equipment after becoming thoroughly familiar with all 
warning, safety notices, and maintenance procedures contained herein. The successful and safe operation 
of this equipment is dependent upon proper handling, installation, operation, and maintenance.  

The perfect and safe operation of the equipment is conditional upon proper transport, proper storage, 
installation and assembly, as well as, on careful operation and commissioning. 

The equipment may be used only for the purposes specified in this publication. 
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CAUTION
 

Electrostatic discharge can damage or cause the failure of semiconductor devices such as 
integrated circuits and transistors. The symbol at right may appear on a circuit board or other 
electronic assembly to indicate that special handling precautions are needed. 

• A properly grounded conductive wrist strap must be worn whenever an electronics 
module or circuit board is handled or touched. A service kit with a wrist strap and static dissipative 
mat is available from Siemens (PN15545-110). Equivalent kits are available from both mail order and 
local electronic supply companies. 

• Electronic assemblies must be stored in anti-static protective bags when not installed in equipment. 

 
 

 

 
DANGER 

 

 

Explosion hazard 
 

Will cause death, serious injury or property damage 
 
• In potentially hazardous atmosphere, remove power from equipment before 

connecting or disconnecting power, signal, or other circuit, or extracting/inserting 
module. 

• Observe all pertinent regulations regarding installation in hazardous area. 
• Ensure all devices are rated for hazardous (classified) locations. 
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1  Introduction 

The Siemens APACS+ PROFIBUS Fieldbus Module (PFM) creates an interface between an APACS+ 
control system and PROFIBUS DP (distributed peripheral) devices. This interface maps PROFIBUS 
devices to I/O channels in an APACS+ environment, extending the domain of ProcessSuite Integrated 
Process Automation Software, including the R4 Framework, an advanced HMI (human-machine 
interface).  The PFM makes it possible for control architectures to include proven APACS+ hardware and 
software as well as third-party PROFIBUS field devices. 

PFM PROFIBUS Fieldbus Module

MBUS

AI/AO
DI/DO

ET200M
Remote I/O

PROFIBUS-DP (12 Mbaud)

Engineering
workstation
(APACS+ 
Development
node)

DP/PA
Link/Coupler

 

 

PROFIBUS-PA (31.25 kbits/sec)
 

HART
devices

 COM PROFIBUS
+
PDM
+
CP 5611 PROFIBUS
card

 

Figure 1–1  APACS+ PROFIBUS Fieldbus Module (PFM) in a Typical Architecture 

1.1 Organization 

Section 1–Introduction to the PFM, Siemens product support, and conventions used in this manual. 

Section 2–Installation of the PFM hardware and software. 



Introduction SD39PFM-1 
 

 
1-2 September 2005 

Section 3–Configuration of the PFM and related PROFIBUS components. In this sense configuration 
consists largely of using software tools to configure the PROFIBUS bus and set devices addresses and 
other parameters. 

Section 4–Maintenance. 

Section 5–Circuit Description. 

Section 6–Spare Parts and Accessories. 

Section 7–Specifications. 

Warranty. 

1.2 Product Support 

Our Technical Support Centers (TSC) offer a variety of technical support services that are designed to 
assist you with Siemens products and systems. Our support engineers have experience with 
troubleshooting, development, system startup, and system test. They will help you to solve your issues in 
an efficient and professional manner. 

Customers in North America can contact Siemens Technical Support Center at 1-800-333-7421, on the 
web at: http://support.automation.siemens.com, or by e-mail: techsupport.sea@siemens.com 

Customers outside North America can contact their local Siemens subsidiary; addresses and telephone 
numbers are listed on the Internet at the web site: http://support.automation.siemens.com. 

When contacting Siemens, customers will be asked to provide site-contact information (name, address, 
and phone number), the product involved and detailed information regarding the nature of the issue. 

Product documentation is now located in the Library forum of the Process Automation User Connection 
at: http://sitescape.sea.siemens.com/. The Process Automation User Connection is a secure site. 
Registration is open to all verified users of Siemens process automation systems. If you are not already, 
and would like to become a member, please visit our Process Automation User Connection web page at: 
http://www.sea.siemens.com/process/support/papauc.html  

Contained within the Process Automation User Connection is the APACS+/QUADLOG Secure Site at:  
http://sitescape.sea.siemens.com/forum/aca-1/dispatch.cgi/f.apacsquadlo forum. This site is only open to 
customers with an active service agreement. It contains all service manuals, service memos, service notes, 
configuration manuals, etc. for the APACS+ and QUADLOG family of products. If you are experiencing 
technical difficulties with the site, please contact SiteScape technical support at: toll free 1-877-234-1122 
(US) or 1-513-336-1474. 



SD39PFM-1 Introduction 
 

 
September 2005 1-3 

A&D Technical Support 
Worldwide, available 24 hours a day:  

 

Beijing 

Nürnberg 

Johnson City 

 

 

United States: Johnson City, TN Worldwide: Nürnberg Asia / Australia: Beijing 
Technical Support  
24 hours a day, 365 days a year 
Phone:+49 (180) 5050-222 
Fax:+49 (180) 5050-223 
E-Mail: ad.support@siemens.com 
GMT:+1:00 

Technical Support and Authorization 
Local time: Monday to Friday  
8:00 AM to 5:00 PM 
Telephone:+1 (423) 262 2522 
or +1 (800) 333-7421 (USA only) 
Fax:+1 (423) 262 2289 
Mail to: techsupport.sea@siemens.com 
GMT: -5:00 

Authorization 
Local time: Monday to Friday  
8:00 AM to 5:00 PM 
Phone: +49 (180) 5050-222 
Fax: +49 (180) 5050-223 
Mail to: ad.support@siemens.com 
GMT: +1:00 

Technical Support and Authorization 
Local time: Monday to Friday  
8:00 AM to 5:00 PM 
Phone:+86 10 64 75 75 75 
Fax:+86 10 64 74 74 74 
Mail to:ad.support.asia@siemens.com 
GMT:+8:00 

Automation and Drives Service and Support International 
http://www.siemens.com/automation/service&support 

The languages of the SIMATIC Hotlines and the authorization hotline are generally German and English. 

1.3 For More Information 

• APACS+™ I/O Module Configuration for Version 4.40 or Higher (CG39-24, Rev 3. or higher). 

• 4-mation Software Messages and Error Codes (document number CG39-21) 
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• Module Diagnostic Error Codes (document number CG39-19) 

• On-line documentation provided with the COM PROFIBUS and the Simatic PDM programs provide 
extensive discussion of the operation of these programs. 

• The authoritative source of information on the procedure for installing a license for Simatic PDM is 
the text file titled “Readme.txt” on the authorization diskette.  Read this file before attempting to 
install a license.  
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2  Installation 

This section focuses on the installation of the following elements of an APACS+™ PROFIBUS system: 

• An APACS+ Fieldbus Module (PFM) and its associated transition board 

• A Siemens PROFIBUS PCI interface card (CP 5611) installed in a PC or a Siemens PCMIA interface 
card (CP 5511) installed in a PC laptop 

• Cabling between these components and other elements of the PROFIBUS system.  

These installation instructions assume that the following components are already installed and in place:  

• An APACS+ controller, backplane, mounting rack, power supply, and enclosure 

• A PC workstation with an M-Bus adaptor for development, storage, and downloading custom 
applications to an APACS+ controller 

The APACS+ system and module rack must be available before the PFM and its transition board are 
installed. Other network components must be available before cabling and software configuration. 

Installation of the APACS+ PFM network includes several major steps. The order of installation is 
flexible, with hardware installation preceding cabling:   

• Installation and cabling of the PFM transition board, then the PFM module 

• Installation and cabling of the Siemens PROFIBUS PC card or laptop PCMCIA interface, including a 
one-time installation of a Windows control panel applet that sets up the interface. 

• Installation and cabling of an optional PROFIBUS DP-to-PA link or link/coupler 

• Installation and cabling of PROFIBUS field devices 

After the APACS+ PFM network hardware is installed, a set of software configuration tools and 
programs prepare the network for data acquisition and control.  

Review and complete the preparatory steps in subsection 2.1 before proceeding with the installation. 

 IMPORTANT 

The PFM installation should be in accordance with the National 
Electrical Code (NEC), other applicable construction, and electrical 
codes. 

The PFM is only to be used for the purposes described by Siemens. 
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2.1 PFM Identification, Delivery, and Handling 

2.1.1 PFM Module Identification 

The PFM module is identified by the letters “PFM” on its bezel and by two nameplate labels. One 
nameplate label is large, similar to the one shown in Figure 2–1, located on the left side of the module. A 
smaller label is located inside the bezel compartment. Both labels contain the  model designation, part 
number/issue level, software version number, and serial number (S/N). The larger label also lists the 
power requirements, and space is provided for information such as safety agency certifications and 
special precautions. The following is typical: 

Siemens Energy & Automation, Inc.

SIEMENS

 

Figure 2–1  Typical PFM Module Identification Label 

2.1.2 Transition Board Identification 

The PFM is installed with its companion transition board assembly. The assembly has the following 
information printed on its surface: 

 
SIEMENS 
APACS+™ 

PFM 
PROFIBUS FIELDBUS 

MODULE 
TRANSITION BOARD 

P/N 16439- 
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2.1.3 Environmental Considerations 

Many industrial environments create severe operating conditions. The conditions where the PFM is 
located must be within the specifications stated in section 6.2. 

To ensure reliable data communications, it is prudent to locate PFM hardware away from sources of 
interference, such as high-current electrical equipment that emits strong electromagnetic fields and 
switching transients. 

High-power EMI-producing equipment should not be connected to any power lines dedicated to PFM 
signal channels.  

2.1.4 Equipment Delivery, Return, and Handling 

The following subsections provide information of interest to shipping, receiving, and warehouse 
personnel. 

2.1.4.1 Predelivery Test 

Each PFM is fully tested and inspected to ensure proper operation. If the module is ordered 
factory-installed in a MODULPAC enclosure or other cabinet, the module is tested as part of the system 
and inspected to ensure proper operation. 

2.1.4.2 Factory Shipment 

Each PFM is enclosed in a static shielding bag and packaged for shipment. Accessories are packaged 
separately. If a PFM is ordered factory-installed in a rack housed in a MODULPAC enclosure or other 
cabinet, the enclosure is bolted to a pallet and wrapped for protection during shipment. 

2.1.5 Return of Equipment within North America  

US Customers: 

• Call the Repair Order PAS Inside Sales/Order Management Group at (215) 646-7400, ext 4RMA 
(4762) weekdays between 8:00 a.m. and 4:45 p.m. eastern time to obtain an RMA number. Mark the 
RMA number prominently on the outside of the shipment.  

• When calling for an RMA number, provide the reason for the return. If returning equipment for 
repair, a detailed description of failure symptoms and system behavior will be requested. Supply a 
purchase order number for repairs.  Follow the TSC specialist's recommendation for battery 
connection, if applicable. 
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• If applicable, you must supply a Material Safety Data Sheet (MSDS) with each item being returned if 
it was stored or used in a location where hazardous materials were present. 

• Package items to be returned in their original shipping containers. Otherwise, package it for safe 
shipment or contact the factory for shipping recommendations. A module must be placed inside a 
static shielding bag to protect it from electrostatic discharge. 

Canadian customers: 

 Contact Siemens Canada. 

2.1.6 Return of Equipment outside North America 

Contact your Siemens Representative.  

2.1.6.1 Equipment Handling and Storage 

The PFM is completely enclosed and can be safely handled without undertaking special ESD 
(electrostatic discharge) handling procedures provided the bezel compartment door is closed and secured. 
DO NOT touch the connector pins on the back of the module. Handle the module carefully and do not 
subject it to excessive shock or vibration. 

The storage temperature and humidity parameters listed in section 6 must be met for storage of a PFM. 

2.2 PFM Installation 

The PFM module plugs into the backplane of the APACS+ system and into a connector on the transition 
board assembly. Before installing the PFM into a module track, secure the PFM transition board to the 
local termination panel. 

2.2.1 Transition Board Installation 

Tool required: slot head screwdriver. 

See Figure 2–2, which shows how the transition board is installed. The transition board assembly consists 
of a PFM transition board, a mounting support, and a set of captive screws. 

1. Identify the slot the APACS+ module rack where the PFM module will be located. 

2. Locate the groove in the extruded spacer beneath the APACS+ module rack backplane. 

3. Slide the top edge of the transition board assembly into the groove on the extended spacer, as shown 
in Figure 2–2. 

4. Rotate the transition board assembly toward the local termination panel, until the alignment pin on the 
panel protrudes through the transition board. 
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5. Secure the assembly to the local termination panel using the captive screws provide with the 
assembly. 

Figure 2–2  Transition Board Installation 

2.2.2 Keying the PFM Module and Rack 

APACS+ Modules are shipped individually packaged in protective, sealed, static shielding bags. Refer to 
subsection 2.1.5 for module handling considerations. 

Each APACS+ slot and each module can be keyed to prevent accidental installation of a module into an 
incompatible slot, which may impair system performance. Module and rack keying is highly 
recommended; see Figure 2–3. 

Modules are keyed at the factory. The keying pattern is unique to each module type (e.g. PFM, ACM, 
CAM, CDI, CDO-DC). 

Extruded Spacer

Alighment Pin

Backplane

Transition board

Captive screw

Captive screw

J3

J4 (PROFIBUS DB-9)

Local termination
panel
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A factory-assembled rack is keyed at the factory. If you are assembling the rack on site, you must key 
each slot according to the module type assigned to it. The slot keying pattern complements the module’s 
keying pattern. Stop plugs are supplied with the rack. 

Before adding a module to a rack, be sure to key its slot. 
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Module bezel
Keying pin locations
(rear view)

Top

Bottom

 

Figure 2–3  Module Rack Mechanical Keying 
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1. Locate the rack Keying Kit supplied with the rack. 

2. Refer to Figure 2–3 and note the rack-keying pattern applicable to the PFM. Also, locate the rack’s 
top and bottom rails. 

3. Press the stop plugs into the appropriate key holes of the top and bottom rails as identified by the 
solid dot keying patterns in the figure. 

2.2.3 Module Installation  

1. Where applicable, refer to your system documentation and note the assigned rack and slot numbers 
for the module to be installed. 

2. Remove the PFM module from its static-shielding bag and ensure that the module’s bezel is keyed. 
Also, check the rack slot assigned to the module to be sure it is keyed. If required, refer to subsection 
2.2.2 for rack keying information. 

3. Insert the module in its assigned slot in the rack. Use uniform pressure to firmly seat the rear of the 
module in the rack’s backplane and transition board connectors. If the module does not seat properly, 
check its keying pattern. A properly seated module has the rear of its bezel flush against the rack’s 
front rails. A keyed module that is not matched to a slot does not engage the backplane or transition 
board connectors or seat flush against the rack’s front rails. 

4. As shown in Figure 2–3, pivot open the bezel’s pivoting top and bottom handles to expose the slotted 
captive mounting screws then secure the module to the top and bottom rails. Close the bezel’s handles 
when finished. 

 
CAUTION 

Do not use the captive mounting screws in the bezel to seat the module. 
Damage to the bezel can result. Properly seat the module before 
tightening the captive screws. 

2.3 Field Wiring 

This section describes making PFM field wiring connections to a PROFIBUS remote device from the 
PFM. This section assumes that tagged field I/O wires have been pulled into the enclosure and are ready 
for preparation and connection.  

2.4 PROFIBUS DP Interface Installation and Cabling 
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DANGER 

 

 

Explosion hazard 
 

Will cause death, serious injury or property damage 
 
• In potentially hazardous atmosphere, remove power from equipment before 

connecting or disconnecting power, signal, or other circuit, or extracting/inserting 
module. 

• Observe all pertinent regulations regarding installation in hazardous area. 
• Ensure all devices are rated for hazardous (classified) locations. 

2.4.1 DP Wire Standards 

PROFIBUS-DP Type-A cable is recommended, and has the following parameters: 

Table 2–1  DP Wire Standards 

Table Column Title Table Column Title 

Impedance: 135 to 165 Ohms 

Capacitance:  < 30 pf/m 

Loop resistance:  110 Ohms/km 

Wire gauge:  0.64mm 

Conductor area:  > 0.34mm² 

Shield: Braid and foil with >80% shield density 

2.4.2 DP Wiring Guidelines 

PROFIBUS-DP uses RS 485 communications protocol, (often referred to as H2).   

• The RS 485 transmission technology is easy to handle, and installation of the twisted pair cable does 
not require expert knowledge.  All devices are connected in a bus structure (multi-drop configuration) 
with up to 32 stations (master or slaves) connected per segment.   

• A DP network can contain a maximum of 126 devices.  When more than 32 stations are used, 
repeaters (line amplifiers) must be used to connect the individual bus segments. 
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• This bus (multi-drop) structure permits addition and removal of stations, as well as step-by-step 
commissioning of the system without influencing the other stations.  Later expansions have no effect 
on stations already in operation.  

• An active bus terminator at the beginning and end of each segment terminates the bus.   To ensure 
error-free operation, the bus terminations must be enabled at each end of the segment.  Siemens and 
other vendors have switchable bus terminators designed into their devices or plug connectors.   
Various well-known manufacturers offer PROFIBUS cable and plug connectors (See the PROFIBUS 
product guide for company names and addresses). 

• When connecting the stations, make sure that the 2 wires are connected with correct polarity.  The red 
wire is for signal B (pin3 - TXD/RXD-positive), and the green wire is for signal A (pin 8 - 
TXD/RXD-negative). 

• The shield braiding and, if present, the shield foil should be connected to protective ground at both 
ends of the cable with good conductivity via shield clamps covering as large an area as possible.  If a 
potential difference occurs between the grounding points, an equalization current can flow through a 
shield connected at both ends. In this case, install an additional potential equalization line. 

• It is recommended that the data lines be kept separate from all high-voltage cables. 

2.4.3 Considerations for Baud Rates >1.5Mbaud 

• Baud rates greater than 1.5 MBaud require the use of special connectors. These connectors (and some 
devices) have built in Inductors, which are necessary in order to run with higher baud rates (as stated 
in the PROFIBUS guidelines). 

• Spurs or stub lines should be avoided for data transmission speeds of more than 500 kbaud, and are 
not allowed when using baud rates greater than 1.5 Mbaud.  Plug connectors are available that permit 
the incoming data cable and the outgoing data cable to be connected directly into the plug connector. 
This type of connector eliminates stub lines, and also allows stations to be connected and 
disconnected without interrupting data communication with the other stations.  

• 12 MBaud installations require a minimum cable length between two stations of 1m/ 3feet. 

A detailed installation guideline is also available from the PROFIBUS Trade Organization (PTO):  PTO 
order number 2.112 

2.4.4 DP Segment, Speed, Distance Constraints 

• Transmission speeds (frequencies) between 9.6 kbaud and 12 Mbaud can be selected. One unique 
transmission speed is selected for all devices on the bus at the time of system commissioning based 
on the devices connected, and the length of the PROFIBUS DP network.  The following table shows 
the maximum bus length corresponding o each selectable baud rate: 
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Table 2–2  DP Segment, Speed, and Distance Constraints  

Baudrate 
(Kbaud) 

Max. Segment length Max. Expansion 
(using repeaters) 

9.6 1000m / 3278feet 10,000m / 32786feet 

19.2 1000m / 3278feet 10,000m / 32786feet 

93.75 1000m / 3278feet 10,000m / 32786feet 

187.5 1000m / 3278feet 10,000m / 32786feet 

500.0 400m / 1311feet 4,000m / 13114feet 

1,500.0 200m / 655feet 2,000m / 6557feet 

3,000.0 100m / 327feet 1,000m / 3270feet 

6,000.0 100m / 327feet 1,000m / 3270feet 

12,000.0 100m / 327feet 1,000m / 3270feet 

2.4.5 Segments and Repeaters 

A segment in PROFIBUS is a section of the bus that is not separated by any repeaters  

The specified cable length can be increased by the use of repeaters (with a maximum of 9 repeaters in 
series).  It should be noted that the Use of more than 3 repeaters in series is not recommended.  

Segments are needed for 

• Extending the length of the bus 
• Installing more than 32 devices 

Segments can be used for 

• Building branch segments 
• Connecting up to 126 stations  

Segment rules 

• A Segment can have a maximum of 32 devices (including repeaters). 
• The first and the last segment can have 31 stations. 
• Segments between the first and last can have a maximum of 30 stations. 
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2.5 PROFIBUS PA Installation and Cabling 

PROFIBUS-PA uses the extended PROFIBUS-DP protocol for data transmission. In addition, the PA 
profile, which defines behavior of the field devices, is used. Transmission technology, in accordance with 
IEC 1158-2, permits intrinsic safety and also allows the field devices to be powered over the bus. 
PROFIBUS-PA devices can be easily integrated in PROFIBUS-DP networks using a segment coupler.  

2.5.1 IEC 1158-2 Transmission for PA 

Transmission technology in accordance with IEC 1158-2 meets the requirements of the chemicals and 
petrochemicals industries. It permits intrinsic safety and allows the field devices to be powered over the 
bus. This technology is a bit-synchronous protocol with continuous current-free transmission. It is often 
referred to as H1. IEC 1158-2 technology is used by PROFIBUS-PA. Transmission is based on the 
following principles:  

• Each segment has only one source of power, the power supply unit.  

• No power is fed to the bus when a station is sending.  

• Every field device consumes a constant basic current at steady-state.  

• The field devices act as passive current sinks.  

• The passive line termination is performed at both ends of the main bus line.  

• Linear, tree and star networks are allowed.  

• To increase reliability, redundant bus segments can be designed.  

For modulation it is assumed that a basic current of at least 10 mA is required by each bus station to 
supply the device. Communication signals are generated by the sending device by modulation from +/- 9 
mA to the basic current.  

2.5.2 Installation Hints for IEC-1158 Transmission 

Usually located in a control room are the process control system, operator control and monitoring devices, 
and the segment coupler implementing the linking of bus segments with IEC 1158-2 technology (PA) to 
segments with RS 485 transmission (DP). Segment couplers adapt the RS 485 signals to the IEC 1158-2 
signals. They provide the current for the remote powering of the field devices. The power supply unit 
limits current and voltage on the IEC 1158-2 segment. 
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Table 2–3  Characteristic Features of IEC 1158-2 Transmission Technology 

Characteristic  Implementation 

Data transmission Digital, bit-synchronous, Manchester coding 

Transmission speed 31.25 kbit/sec, Voltage Mode 

Data security Preamble, error-proof start and end delimiter 

Cable  Two wire twisted pair cable (shielded/unshielded) 

Remote powering  Optional, via data lines 

Explosion Protection type  Intrinsically safe and non-intrinsically safe operation possible

Topology Line and tree topologies, or a combination 

Number of stations  Up to 32 stations per line segment, maximum total of 126 

Repeater  Can be expanded with up to 4 repeaters 

For network topologies PROFIBUS-PA offers both tree and line structures, or a combination of the two. 
The line structure permits connection points along the fieldbus cable similar to the installation of power 
supply circuits. The fieldbus cable can be looped through the field devices. Branches for connection of 
one or more field devices are also possible. The tree structure can be compared to the classic field 
installation technique. 

Table 2–4  Specification of the Reference Cable or IEC 1158-2 Transmission 

Characteristic  Implementation 

Cable design shielded twisted pair cable 

Conductor area (nominal) 0.8 mm² (AWG 18) 

Loop resistance (direct current) 44 Ohms/km 

Impedance at 31.25 kHz 100 Ohms ±20% 

Attenuation at 39 kHz 3 dB/km 

Capacitive asymmetry 2 nF/km 
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A combination of tree and line structures permits optimization of the bus length and adjustment to 
existing system requirements. Maximum permissible stub line lengths must be considered. A two-wire 
cable (shielded or unshielded) is used as the transmission medium. It is recommend that you use the 
reference cable specified in the Table 2–4. Other cables with larger conductor areas are also possible. For 
details refer to the installation guidelines for PROFIBUS-PA from the PROFIBUS Trade Organization 
(PTO). The order number is 2.092. 

Both ends of the main bus cable are equipped with a passive line terminator which consists of an RC 
element switched in series with R=100 Ohms and C=1 µF. When a bus station is connected with its poles 
reversed, this has no effect on the functionality of the bus. It is recommend that devices be equipped with 
automatic polarity recognition. The devices then operate correctly no matter what the assignment of input 
terminals to the data signals is. 

The number of stations which can be connected in one segment is limited to 32. This number is further 
restricted by the type of explosion protection class selected and any powering over the bus. When 
intrinsically safe networks are operated, both the maximum supply voltage and the maximum supply 
current are specified within clearly defined limits. Even when intrinsically safety is not required, the 
power of the remote power supply unit is limited. 

2.5.3 External Power Supply 

Connection of bus-powered devices and externally-powered devices on an intrinsically safe bus is 
permitted if the externally-powered devices are equipped with appropriate isolation in accordance with 
EN 50 020. 

2.5.4 Fiber Optic Transmission  

Fiber optic conductors can be used for PROFIBUS for applications in environments with very high 
electromagnetic interference and to increase the maximum distance for high transmission speeds. Two 
types of conductors are available: inexpensive plastic fiber conductors for distances greater than 50 m or 
glass fiber conductors for distances greater than km.  

Siemens and other vendors offer special bus plug connectors with integrated conversion of RS 485 signals 
to fiber optic conductors and vice versa. This provides a very simple method of switching between RS 
485 transmission and fiber optic transmission within one system. See PROFIBUS guideline 2.022 for the 
specification of the PROFIBUS-FO transmission technique. An overview of the fiber optic components 
which are available can be found in the PROFIBUS product guide. 

2.6 Engineering Workstation with Modulbus Interface 

This procedures in this manual assume the availability of an engineering workstation with a Modulbus 
Interface and the current versions of the following software: 

• ProcessSuite  

• 4-mation 
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2.7 GSD Files 

Manufacturers of PROFIBUS devices supply devices characteristics in structured ASCII text files 
generically known as “GSD” files. These files generally have .gsd filename extensions, hence the name, 
although they may also have .gse extensions, where e indicates English. Device characteristics listed in 
GSD files include vendor identification, supported baud rates, timing specifications, features, and I/O 
signals. GSD files are freely available from manufacturers and are usually supplied on diskette or CD and 
shipped with the devices they encompass. GSD files may also be downloaded from manufacturer’s web 
sites. A device-specific GSD file is required for every device installed on a PROFIBUS.  

Configuration software runs on the PC or laptop with the CP 5611 interface card installed. The software 
expects to find GSD files in the following directory of that PC or laptop: 

X:\SIEMENS\CPBV50\GSD, where X represents a drive designation.  

Before attempting to install a PROFIBUS device, ensure that its GSD file exists in the correct directory.  

2.8 Preparing the PROFIBUS DP Configuration Workstation 

Siemens provides interfaces that connect a PC or laptop to a PROFIBUS DP bus. The PC interface is a 
CP 5611 PCI card. The laptop interface is a CP 5511 PCMCIA card. After these interfaces are installed 
and set up properly, they are functional equivalents. The installation and setup procedures differ slightly. 

• Subsection 2.8.1 pertains to laptops.  
• Subsection 2.8.2 pertains to PCs. 

2.8.1 Installing COM PROFIBUS and the CP 5511 Interface in a Laptop 

Install COM PROFIBUS on a laptop before installing the CP 5511 PROFIBUS interface  

Prerequisites: 

• CD: COM PROFBUS  V5.1 (PS02-2324V3.02) 
• CP5511 PCMCIA CARD F/PROFIBUS (6GK15511AA00) 
• Manufacturer’s instructions for installing PCMCIA card into a laptop 
• Compatible operating system software (see the documentation accompanying COM PROFIBUS, 

Simatic PDM, and the CP 5511 interface).  

The COM PROFIBUS installation program provides on-screen messages and dialog boxes to guide you 
in making installation selection appropriate for your system. The program asks you to do the following: 

• Read and agree to license provisions. 

• Select a language for installation instructions and a language for on-line help. 

• Select a destination directory for installed files (you can change the recommended drive and directory 
if you wish). 
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• Select Memory Card Parameter Assignment (select No EPROM Driver). 

• Install Adobe Acrobat Reader 3.0 on your system (read note below before installing). 

NOTE 

Do not install Adobe Acrobat Reader 3.0 on a system used to display 
documents provided on the APACS+™ Electronic Manuals CD. Some 
documents on this CD require Acrobat Reader 4.05 or higher, which is 
included on the APACS+™ Electronic Manuals CD. 

Acrobat Reader 4.05 and 5.0 are also available as free downloads from 
www.adobe.com. Acrobat Reader version 4.05 and 5.0 are compatible 
with PDF files that open with earlier versions. 

1. Install the PROFIBUS interface and connect the card with a properly terminated cable to at least one 
DP device. 

2. Insert the COM PROFIBUS V5.1 CD into the CD-ROM reader. The CD typically runs automatically 
when inserted into a CD-ROM drive (if the installation program does not start automatically, use the 
Windows Explorer program to locate the Autorun.exe program in the root directory. Double-click the 
program name or icon to start the installations procedure.  

3. Follow the instruction displayed on the screen, until the program reaches the Install / Remove 
Interfaces window (shown below). At that point select the Close button without clicking Install. 

 

 

4. Exit the program and shutdown Windows. Turn the laptop off and leave it off for a few moments.  
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5. Restart Windows.  

6. Following instructions provided by the laptop manufacturer, insert the 5511 interface into the 
PCMCIA slot. Operating-system software recognizes and installs drivers for the card. Follow any 
instructions that require you to restart the laptop.  

7. Follow the procedure in subsection 2.8.6.2 

8. Follow the procedure in subsection 2.8.3. 

9. Follow the procedure in subsection 2.8.6.1 

10. Follow the procedure in subsection 2.8.4. 

2.8.2 Installing the CP 5611 Interface Card and COM PROFIBUS in a PC 

Prerequisites: 

• CD: COM PROFIBUS v 5.1 (PS02-2324V3.02) 
• CP5611 PCI CARD F/PROFIBUS (6GK15611AA00). The user may elect to install this CP 5611 

PROFIBUS card into an APACS+ Development Node or choose to have a separate PC for 
PROFIBUS configuration tools. 

• Manufacturer’s instructions for installing a PCI card 
• Compatible operating system software (See the documentation accompanying COM PROFIBUS, 

Simatic PDM, and the CP 5611 interface, all of which were compatible with Windows NT when the 
PFM was under development. The list of compatible operating system software is likely to expand as 
these products are revised and upgraded.)  

Follow the instructions provided by the PC manufacturer to open the PC chassis and install a PCI card 
(the 5611 is a PCI card) in an empty PCI slot.  Follow safe installation practices: turn the system off 
before removing the chassis, use a static-dissipating wrist strap, and avoid touching component leads or 
card-edge connectors. Return the chassis cover and secure with fasteners provided before turning the PC 
back on.  

CD required: COM PROFBUS v 5.1 (PS02-2324V3.02) 

The COM PROFIBUS installation program provides on-screen messages and dialog boxes to guide you 
in making installation selection appropriate for your system. The program asks you to do the following: 

• Read and agree to licensing provisions. 

• Select a language for installation instructions and a language for on-line help. 

• Select a destination directory for installed files (you can change the recommended drive and directory 
if you wish). 

• Select Memory Card Parameter Assignment (select No EPROM Driver). 
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• Install Adobe Acrobat Reader 3.0 on your system (read note below before installing). 

NOTE 

Do not install Adobe Acrobat Reader 3.0 on a system used to display 
documents provided on the APACS+™ Electronic Manuals CD. Some 
documents on this CD require Acrobat Reader 4.05 or higher, which is 
included on the APACS+™ Electronic Manuals CD. 

Acrobat Reader 4.05 and 5.0 are also available as free downloads from 
www.adobe.com. Acrobat Reader version 4.05 and 5.0 are compatible 
with PDF files that open with earlier versions. 

• Establish interfaces for the Set PG/PC Interface control panel applet.  

1. Install the PROFIBUS interface and connect the card with a properly terminated cable to at least one 
DP device. 

2. Insert the COM PROFIBUS V5.1 CD into the CD-ROM reader. The CD typically runs automatically 
when inserted into a CD-ROM drive (if the installation program does not start automatically, use the 
Windows Explorer program to locate the Autorun.exe program in the root directory. Double-click the 
program name or icon to start the installations procedure.  

3. Follow the instruction appear on the screen.  

4. When the Install / Remove Interfaces window appears, select CP5611 from the list (which may vary 
from the one shown below) and click the Install  button. Then click the Close button: 
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5. When the Set PC/PG Interface window appears, Select (highlight)  
“CP5611(COM PROFIBUS)” to ensure that the  Access Point of the Application is  
COM_PROFIBUS   --> CP5611(COM PROFIBUS). You may have to select  
COM_PROFIBUS   --> CP5611(COM PROFIBUS) from the drop down menu associated with 
the  Access Point of the Application. 

 

NOTE  

The proper Access Point of the Application differs in COM PROFIBUS 
and SIMATIC PDM (and Lifelist.exe).  After the access points are set up 
properly (subsection 2.8.5), the applications themselves select the 
necessary access point.  

6. Follow instructions to finish installation, selecting not to launch COM PROFIBUS when installation 
concludes. 
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2.8.3 Installing SIMATIC PDM 

CD required: PDM V5.1 + SP2  
Optional Diskette: PDM license (you can install PDM now and install the license later if you wish) 

This procedure installs SIMATIC PDM and the lifelist program.  

1. Insert the PDM V5.1 + SP2 CD into the CD-ROM reader. The CD typically runs automatically when 
inserted into a CD-ROM drive (if the installation program does not start automatically, use the 
Windows Explorer program to locate the Autorun.exe program in the root directory. Double-click the 
program name or icon to start the installations procedure.  

2. Follow the on-screen instructions and prompts to do the following: 

• Accept license agreements. 

• Select languages for setup and for documentation. 

• Enter your name and organizational affiliation. 

• Select a target (destination) drive for the program. 

• Select program components (select both SIMATIC Manager and SIMATIC PDM). 

• Select a destination directory for program components (this can differ from the default). 

• Select Memory Card Parameter Assignment (select No EPROM Driver). 

• Insert your authorization diskette (if you skip this step you can return to it by following the procedure 
in subsection 2.8.5 

2.8.4 Creating a Desktop Shortcut to Lifelist.exe 

The Lifelist program, which scans the PROFIBUS for installed devices, is useful for listing and 
confirming PROFIBUS addresses. If the program works as expected, you can assume that there are no 
faults preventing you from running the PDM program. It may be useful to make a desktop shortcut to the 
Lifelist program after PDM is installed, so that Lifelist can be launched easily. Such a desktop shortcut 
may reduce the time required to configure and assign parameters to PROFIBUS devices, a process that 
tends to be iterative.  

1. Select Windows Explorer > Tools > Find > Files or Folders… 
In the Named: field, enter Lifelist.exe. 
You may have to change drive designations in the Look in: field 
Click the Find now button. 
The Lifelist.exe program appears in an expansion of the window. 

2. Select and right-click the Lifelist.exe program icon. 
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3. Select Create Shortcut. 
A message cautions you that the program cannot create a shortcut where you have asked, but will 
offer to create it on the desktop 

4. Click the Yes button to create the desktop shortcut.  

2.8.5 Installing the Simatic PDM License 

The Simatic PDM license is distributed on one or more Siemens diskettes. Authorization to use the PDM 
program, like a token, can be held by only one mass storage medium at a time. Authorization can exist 
either on the distribution diskette or on a hard disk drive of the workstation on which it has been installed, 
but not both places. It is not possible to copy the authorization by copying the diskette or the hard disk 
drive.  

To manage authorization, the program AuthorsW.exe on the diskette does the following: 

• Displays the available Simatic licenses on local disks of the workstation or laptop from which 
AuthorsW.exe has been run 

• Installs licensing from the diskette to a hard disk drive 

• Returns licensing from hard disk drive to the diskette 

A text file on the diskette titled “Readme.txt” provides detailed instructions for using the program and 
important cautions about its licensing restrictions. These include discussion of 

• Prohibitions forbidding write-protecting the diskette 
• Damage to the licensing authorization due to computer virus 
• Cautions against running a disk optimizing program (defragmenter) on a hard disk drive with 

licensing installed 
• Partial backup of licensing authorizations 
• Securing emergency, temporary licensing in the event of a catastrophic failure 
• Prohibitions forbidding changing names and attributes of files and directories created by the program 

WARNING 

The authoritative source of information on topics related to licensing is 
the text file on the diskette titled “Readme.txt.” Failure to heed the 
information in this file could result in data loss and an inability to run 
configuration programs.   

Having read and understood the text file on the diskette titled “Readme.txt,” installation of the licensing 
authorization is straightforward.  

1. Insert the authorization diskette in your diskette drive. 

2. Run the program AuthorsW.exe 
A window opens showing the authorizations for the mass storage medium selected in the left pane. In 



SD39PFM-1 Installation 
 

 
September 2005 2-23 

the window shown below, the authorizations for the selected Drive C: are displayed. 
 

 

3. To move an authorization from one drive to another, drag it from the right pane and drop it on the 
appropriate drive on the left pane. In the illustration above, it would be possible to remove 
authorization to run SIK/SIMATIC PDM Basis Evaluation from the selected drive (C:\) and either 
return it to the authorization diskette (A:\) or move it to another drive. 

4. When you have made desired changes, wait for drive LEDs to stop, and click File > Exit. 

2.8.6 Setting the PG/PC Interface through its Control Panel Applet 

The PC/PC interface begins with the CP 5611 Interface card installed in a workstation or a CP 5511 
installed in a laptop. These cards connect the workstation or laptop directly to the PROFIBUS DP 
network and indirectly to PA devices through intermediaries. The card enables the COM PROFIBUS and 
PDM programs running on the workstation to communicate with PROFIBUS masters and slaves. The 
proper setting for the card differs for COM PROFIBUS and Simatic PDM, but these programs select the 
correct settings automatically after the card is set up for initial use. 

The Set PG/PC Interface control applet, which controls access settings,  is installed in the Windows 
Control Panel when COM PROFIBUS is installed.  

2.8.6.1 Setting the CP 5611 or 5511 Interface for PDM 

Prerequisite information: the operating baud rate of the PROFIBUS DP network (you can change the 
baud rate setting later if you change the network’s baud rate). Note: the factory default baud rate 
for the PFM is 19.2 kbps and its default PROFIBUS address is 0. 

1. On the PC or laptop with the CP 5611 or 5511interface installed, select Start > Settings > Control 
Panel > Set PG/PC Interface. 
The “Set PG/PC Interface” window appears: 
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2. Ensure that the “Access Point of the Application:” is 
S7ONLINE (STEP 7)  --> CP5611(PROFIBUS) for a workstation or 
S7ONLINE (STEP 7)  --> CP5511(PROFIBUS) for a laptop 

 You may have to use the drop-down menu associated with the access point. When you have done this, 
the Properties box becomes available as an option, as shown in the screen capture above. 

3. Select the Properties box. A window like the following appears: 
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4. Ensure or confirm that the settings are as follows: 

• Check: “PG/PC is the only master on the bus” (this selection may be non-intuitive, because the 
PROFIBUS DP bus probably includes at least one other master, the PFM). 

• Ensure that the “Address” (of the CP 5611 or 5511 interface) is 0. 
• For “Transmission Rate:” select the baud rate of the PROFIBUS network. 
• For “Profile;” select Standard. 
• In the Network Configuration selection, check Include network configuration below. 
• Ensure that Master is 1. 
• Ensure that Slaves is 0. 

 Click the OK button. 
The window closes, returning to a list of control panel applets. 
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2.8.6.2 Setting the CP 5611 or 5511 Interface for COM PROFIBUS 

1. On the PC or laptop with the CP 5611 interface card installed, select Start > Settings > Control Panel 
> Set PG/PC Interface. 
The “Set PG/PC Interface” window appears: 

 

Figure 2–4  Access Point for COM PROFIBUS 

2. Select COM_PROFIBUS from the pull down menu labeled Access Point of the Application. 

3. Select (highlight) “CP5611(COM PROFIBUS)” to ensure that the  Access Point of the Application 
is  
COM_PROFIBUS   --> CP5611(COM PROFIBUS)  for a workstation or 
COM_PROFIBUS   --> CP5511(COM PROFIBUS)  for a laptop.. 

4. Click the OK button the to exit the control applet. 
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3  Configuration 

A set of software tools creates an interface between an APACS+ controller, a PROFIBUS Fieldbus 
Module (PFM), and a PROFIBUS network.  

The purpose of this interface is to integrate PROFIBUS field I/O devices seamlessly into a Siemens 4-
mation software environment. Applications running in this environment may rely solely on PROFIBUS 
devices for field I/O, or they may include a mix of PROFIBUS devices and devices connected to the 
extensive line of analog and discrete I/O modules provided by Siemens. 

Siemens configuration software, installed through procedures listed in Section 2.0, consists of the 
following: 

• Set PG/PC Interface  a control panel applet for configuring a Siemens CP 5611 or 5511 interface card 
and establishing PROFIBUS DP bus characteristics 

• COM PROFIBUS, for configuring devices on a DP bus 

• Lifelist, a special-purpose program for identifying, discovering, and documenting DP and PA devices 

• PDM, a program for setting parameters of DP/PA devices and monitoring or simulating I/O 

An APACS+ PROFIBUS network consists of these elements: 

• An engineering workstation for developing and monitoring the Siemens 4-mation application that 
runs on the APACS+ controller. This workstation includes a Siemens Modulbus interface card, 
connected to the APACS+ system containing the PFM module.  

• A second PC workstation or laptop with a Siemens PCI CP 5611 interface card or a PCMCIA  CP 
5511 interface. This workstation or laptop provides a hardware platform for PROFIBUS 
configuration tools that configure the PFM and PROFIBUS slave devices. 

• An optional PROFIBUS DP/PA link/coupler, which  provide the hardware and software interface 
between  the PFM and PROFIBUS PA devices. 

• PROFIBUS DP and PA field devices from Siemens and other manufacturers. 

NOTE 

Configuring a PROFIBUS network for use in an APACS+ environment 
requires only a small fraction of the functions available in the 
configuration programs COM PROFIBUS and PDM. The instructions in 
this manual make no attempt to describe features that are not applicable 
to an APACS+ environment. Do not change settings or selections unless 
you are specifically told to do so or unless you possess expert knowledge 
and fully understand the implications of your actions. 
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The procedures in this section do not explicitly remind you to save your work to hard disk or to back 
them up on removable media although it is obviously prudent to do so. Configuration developed in COM 
PROFIBUS  and PDM are saved automatically, but you must explicitly save incremental versions of your 
configurations under different files names if you wish to revisit them. 

3.1 Populating  the PROFIBUS DP Network with COM PROFIBUS 

Identifying and configuring DP devices with COM PROFIBUS is an iterative process, repeated until all 
the devices are installed on the DP network. It is possible to interrupt the process, save  the incremental 
version as a file, and return later, building on previous effort. It is not unusual to run the program 
repeatedly as you systematically add devices to the network. 

If you already have an active DP configuration loaded into a master, you can import it into COM 
PROFIBUS from the master and load it into a new configuration. See subsection 3.5. You might elect to 
do this if you already have a working network and wish to add devices to it. 

1. From the PC with the CP 5611 (or laptop with CP 5511) installed, run COM PROFIBUS.  Select  
Start > Programs > Siemens COM PROFIBUS V 5.1 > COM PROFIBUS V 5.1. 

 

 The program displays a new, blank network, with a single purple line representing the PROFIBUS 
DP bus.  
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2. Populate the PROFIBUS DP network by expanding the DP Master and DP Slave lists in the left pane, 
also know as the “Hardware Catalog,” then dragging and dropping devices into position on the 
PROFIBUS DP bus, represented by the purple line.  You must add a master first. Start with the PFM 
module. 

Devices in the left pane are listed in an indented outline format. Clicking a “+” sign expands a list, 
revealing subordinate objects. A “-“ sign indicates that there are no subordinate elements in the list. 
Clicking a “-“ sign contracts a list, providing a better overview of the list content, but less detail. 

The following window shows the DP Master list expanded to reveal the PFM, a bus master, which has 
been dragged and dropped onto the PROFIBUS DP network.  
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Note that the COM PROFIBUS has assigned the first available PROFIBUS address, 1,  to the device. As 
additional devices are placed on the bus, the program increments the PROFIBUS address from the lowest 
available number. An address assigned automatically may be inappropriate and may require modification.  

NOTE 

At least one DP slave connected to a PFM must be at an address lower 
than or equal to 32. 

Note, too, that the CP 5611 interface card (or laptop with CP 5511 PCMCIA card), a master assigned the 
address 0, should not be added to the graphical display of the DP network. This may be non-intuitive. 

The position of a device on this graphical representation of the bus is important only to the degree that it 
enables you to visualize and understand your system.  It doesn’t matter, for example, whether a device is 
dropped above or below the purple line representing the bus. The PROFIBUS address of the devices is, of 
course, critical and must be unique and match the setting of the devices itself. Consult the documentation 
supplied with each device to determine how to set its address.  

If PROFIBUS PA devices are used in the system, the DP bus may include a DP/PA link and coupler, 
providing an interface between the DP bus and the PA bus. A DP bus may include other DP devices as 
well. The following illustration shows a DP bus consisting of the following: 
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• PFM master 
• DP/PA link and coupler (the Siemens DP/PA Link IM157, is found under the category 

“DP Slave > Gateways.”) 
• ET 200M  
• ET 200B 
 

 

Figure 3–1  Typical PROFIBUS DP Network with an DP/PA-Link 

If a device does not appear on the lists in the left pane of the COM PROFIBUS window, the device’s 
GSD files does not exist in the specified directory (see subsection 2.7). You must secure a suitable GSD 
file and copy it to the directory C:\SIEMENS\CPBV50\GSD. Then from COM PROFIBUS, select 
File > Read in GSD Files, to make the GSD file and the device it represents available to the program.  

3.2 Configuring DP Devices 

1. Right-click a DP device and select the Properties. The illustration below shows the “Properties…” 
menu choice among others available after selecting and right-clicking device. 
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Figure 3–2  Right Clicking for Device-Specific Menus 

The essential parameter is the PROFIBUS address, which must match the address assigned to the device. 
For DP devices some mechanical means, such as rotary switches or dual in-line package (DIP) switches, 
sets the PROFIBUS address.  The Siemens CP5611 or 5511 interface card ordinarily takes address 0 and 
the PFM module takes address 1. The usual recommendation is that PROFIBUS devices be assigned the 
lowest possible addresses to ensure efficient scanning after the network is configured and running.  

If you change a switch setting on a slave device, it may not recognize its new address until it has been 
powered off and then on again. For slave devices, it necessary to ensure that the “Parm.assign master” 
(parameter assigning master) is the PFM. In the illustration below, the PFM is identified by its 
PROFIBUS address and name: “#1, Siemens PFM Master.” 
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3.3 Configuration of DP/PA Link/Coupler Devices 

A gateway device interfaces PROFIBUS PA devices with the PROFIBUS DP interface of the PFM. 
Siemens offers two such devices with different performance, complexity, and cost.  

3.3.1 DP/PA Coupler 

A DP/PA coupler provides a physical interface between DP and PA devices.  A coupler has no 
PROFIBUS address and is transparent to the bus. The DP/PA coupler typically supplies power to the PA 
devices that are attached to it. The number of PA devices connected to a coupler is typically limited by 
the power-supply current they draw. 

Networks that connect PA devices to the DP bus solely through a coupler are common and cost effective 
for networks consisting solely of PA devices. Where  PA devices are connected to the DP network solely 
though a DP/PA coupler, the PA devices must be added to the network with COM PROFIBUS and given 
unique PROFIBUS addresses. The PA devices are thus seen as slaves on the DP bus and scanned like 
other DP devices. 

The baud rate of the DP bus when using a coupler must be set to 45.45 kbaud. In networks consisting of a 
PFM and PA devices 45.45 kbaud should be adequate. 

This is an important concern, so much so that the COM PROFIBUS program intercepts an attempt to 
install a devices that cannot handle the current DP baud rate: 



Configuration SD39PFM-1 
 

 
3-8 September 2005 

 

As shown in the illustration below, the SITRANS P and SITRANS T3K are both PA devices. The DP/PA 
coupler is not shown because it is invisible to the DP network. Without it, however, the PA devices would 
be physically incompatible with the DP cabling. The illustration below, as provided by COM PROFIBUS, 
thus provides a logical, rather than physical, picture of the DP bus.  

 

3.3.2 DP/PA Link/Coupler 

A DP/PA link is an interface between a DP network PA devices, but unlike a coupler it is not transparent. 
A link has a unique PROFIBUS address and is acknowledged as a DP device on the DP bus. When a 
DP/PA link is mated with a coupler, the combination becomes a link/coupler pair. A single link can 
support multiple couplers (a maximum of 5).  When shown graphically by the Lifelist.exe program a 
link/coupler is represented by a circle, half purple, representing the conventional color of DP cables, and 
half blue, the color of PA cables, emblematic of its position in both DP and PA environment (at address 
15 in the illustrations): 
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The link/coupler is a master on the PROFIBUS on the PA bus and becomes both a physical and software 
interface between the DP bus and a PA bus. PA devices connected to a coupler are assigned PROFIBUS 
addresses that are unique to the PA side of their link. Communications between the DP master and the PA 
devices are handled through the link/coupler. A DP master sees only the PROFIBUS address of the link, 
the coupler has no address, and the addresses of individual PA devices are hidden from the DP master.  

The chief advantage to using DP/PA link/couplers is that the link can communicate with PA devices at 
the PA baud rate, but permit the DP bus to operate at  any DP speed, up to 12 Mbaud. 

In COM PROFIBUS a DP/PA link/coupler requires additional configuration to accommodate PA devices 
connected to it.  

1. Right-click the link coupler to generate the device-specific menu shown in Figure 3–2 

2. Select Configure… Then select Module. 
The following window appears: 

 

 Observe the following when adding modules:  
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• There can be no gaps in the “Identifier” list. A position can be either be “PA address not used” or 
one of the listed modules. Modules are listed if their they are included in the GSD file for the link 
(Siem8052.gse). To add an unlisted PA device type to the DP/PA link configuration, the link 
GSD file must be updated. As the term is used in the “Module selection for position X “list, a 
module represents either a PA device or a PA device module.  

• It is considered a good practice to keep positions allocated to “PA address not used” to a 
minimum to ensure efficient scanning and data processing.   

• The PROFIBUS PA address of the PA devices determines their position in the module list. Since 
some PA devices are set (or changed) through software, their position should reflect the address 
they will ultimately have (equal to the position number  + 3). This means that the first available 
PROFIBUS PA address for devices connected through a link/coupler is 3. A device in position 1 
of the identifier list  will be assigned the PROFIBUS address 4, the device in position 2 will be 
assigned the PROFIBUS address 5, and so forth. 

NOTE 

The PFM requires at least one PA slave connected to a DP/PA link to be 
at an address lower than or equal to 32. 

• In a system with more than one DP/PA link/coupler, it is possible to have more than one PA 
device with the same PA address because the master communicates with the DP/PA link/coupler 
using the link/coupler’s unique DP address. The PA devices connected to a link/coupler are 
invisible to the master. Their addresses must be unique to their PA bus, but not to the entire 
network. 

3. Add modules to the list, making a note of their PROFIBUS addresses, which will be required  by the 
Siemens PDM program. After you have added the first module (or “PA address not used”), the focus 
of moves to the next position, and so forth. 

4. The following window shows a configuration ready for confirmation through the OK button. 
Identifier position 0 and 1 have been assigned  “PA address not used” because the PROFIBUS 
address of the first PA device (in position 2) has a PROFIBUS address is 5 (PROFIBUS address = 
position + 3). The second device in the list has a PROFIBUS address of 6.  After adding the last 
module, click the OK button.  
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Figure 3–3  PA Devices Occupying Positions in DP/PA Link 

3.4 Exporting and Activating a DP Configuration 

When the COM PROFIBUS configuration is complete or at a stage where it is ready for commissioning 
or testing, it must be exported to the PFM. 

1. Select the PFM, the master, by right-clicking  its icon in the right pane of the COM PROFIBUS 
window. Select File > Export > DP Master… See the illustration below: 
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 A Window like the following appears: 

 

2. Ensure that “Adapt HSA” is selected, and click the OK button. 
The following window appears: 
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 This message is not cause for alarm and will appear whether the master is running or halted. 

 Ensure that the “Address of the master on the bus:” setting corresponds to the address of  the correct 
PFM master (there can be multiple PFMs on a network).  Click the Yes button. 

 The following window appears:  

 

 If a message indicating a baud rate error appears, repeat the procedure in subsection 2.8.5, reducing 
the baud rate to match the rate of the slowest DP device. Then return to the beginning of the 
procedure in this subsection (3.4) 
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3. If there are no errors, the following window appears: 

 

 Click the Yes button to transfer the parameter set to the PFM.  

3.5 Importing an Active DP Configuration 

Configuring and commissioning a network is seldom a linear process. Project requirements change, and it 
is common to take tentative steps, to reconsider, and to begin again.  

COM PROFIBUS includes a feature that imports an Active DP Configuration into a blank, unnamed 
configuration. You can import a known-good configuration,  then store the configuration as a file for 
subsequent recall,  or you can modify a known-good configuration based upon new information or 
constraints.    

1. Start COM PROFIBUS. 

2. Select File > New. 

3. Select  File > Import > DP Master… 

4. Select Siemens PFM Master. 

5. Ensure that the  PROFIBUS address setting is 1, corresponding to the address of the PFM. 

6. Click the OK button.  
The existing DP configuration is loaded into COM PROFIBUS, with device icons appearing on the 
DP bus. 

NOTE 

The import function does not import device configurations if there is not 
GSD file installed for the device (see subsection 2.7). 

3.6 Using the Lifelist Program to Document  the Network 

The Simatic PDM Lifelist program is helpful for confirming that COM PROFIBUS has set up the DP 
network properly and for determining the addresses of devices on PA networks.  
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1. Run Lifelist by executing the Lifelist.exe program. See subsection 2.8.4 for instructions for finding 
this program and creating a shortcut to it. 

2. Ensure that the Settings box selects “Scan PROFIBUS DP & PA via DP/PA Link” if your system 
contains a DP/PA Link.  
Unless you have a reason to change the address range to be scanned, leave LSA and HSA at their 
defaults. 
Click Get lifelist. The following list of installed network components is typical. Note that PROFIBUS 
DP elements are rendered in purple and PA elements are rendered in blue. 

 

3. Make a note of the contents of the lifelist or select  “Write lifelist to file” to put a shortcut to the list 
on the desktop. 

3.7 Setting Up PROFIBUS Devices with SIMATIC PDM 

The program SIMATIC PDM sets up PROFIBUS PA devices and automatically stores the setting on the 
hard disk.  
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The procedure in this subsection explains the first-time setup of PA devices. The settings are stored in a 
“parameter table” that is stored with each named PDM configuration. It is also possible to read the 
parameter table from an on-line device and then save it to a PDM configuration. To do this, complete step 
1 through 12 and then select Device > Load into PG/PC from the menu bar. 

1. Start the PDM program by selecting Start > Simatic > SIMATIC Manager 

 

2. Select File, then New and enter a new project name. 

3. Select View > Process Device Network View: 

 
 

4. Expand the list in the left pane by clicking the “+” sign as necessary to see network components. 
In the left pane, select  and right-click the networks icon. 
 Select Insert > Insert new object > PC. 
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5. Expand the list in the left pane by clicking the “+” sign as necessary. 
In the left pane, select and right-click the PC icon. 
Select Insert > Insert new object > DP Interface. 

6. Expand the list in the left pane by clicking the “+” sign as necessary. 
In the left pane, select and right-click the networks icon 
Select Insert > Insert new object > PROFIBUS DP net 

7. Expand the list in the left pane by clicking the “+” sign as necessary. 
In the left pane, select PC. 
In the right pane, right-click the DP interface icon. 
An object menu appears. 
Select Object Properties… from the menu. 
The “Properties of DP interface” window appears: 

 

 Select the Network tab. 
Select “PROFIBUS DP net.” 
Click the OK button (not shown in the illustration) 

8. In the left pane, select the PROFIBUS DP net icon and right-click. 
Select Insert new object > DP-PA link. 

9. In the left pane, select the PROFIBUS DP net icon. 
In the right pane,  right-click the DP-PA link icon.  
An object menu appears. 
Select Object Properties… from the menu. 
The Properties of the DP-PA link window appears. 
Select the Connection tab in the Properties of DP-PA link window  (shown below). 
Change the PROFIBUS DP address as necessary (the default is 126). The correct address should be 
available from the Lifelist, (see procedure in subsection 3.5). This address should also match the 
address determined by switches on the device. The illustration below show the address changed to 7. 
Click OK when the address is correctly set. 
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10. In the right pane, select the DP-PA link icon and right-click. 
Select Insert new object > PROFIBUS PA device. 
A window opens giving you an opportunity to name the device, indicate the address of the first 
device, and specify how many more devices are connected to the DP-PA link. Additional devices are 
named automatically “PA PROFIBUS devicen” and added to the list of PA devices in the left pane. 
You are not require to create a complete list of devices in one step. You can return to the “Insert new 
object” function and add devices individually. 

 

11. When the SIMATIC PDM Device Selection window opens, select the device from an indented 
listing. In the window below provide as an example, the device to be managed is a Siemens 
SITRANS P differential pressure sensor. Click OK when you have found your device. 
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12. Starting in the right pane and continuing with each device in turn, select the devices and right-click 
them. Select the Open Object from the menu, as shown in the example below 
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 A license window appears, followed by a window asking whether you are a maintenance engineer or 
a specialist. Select specialist for access to all the parameters and click the OK button. 

 

The differences between the operations permitted to maintenance engineers and specialists are provided 
in depth in the on-line help. For purpose of initial configuration and system development, select 
specialist. 

13. The next window provides a comprehensive means of examining and changing the characteristics of 
the device. Setting the parameters requires detailed knowledge of the devices, its I/O characteristics, 
and its role in a system.  The example below shows only of fraction of the characteristics that pertain 
to a Siemens SITRANS P pressure transmitter. To see the other characteristics, you could use the 
elevator bar at the right of the window, or click in the left pane to move more directly to the topic of 
interest.  If you change any elements, the program gives you an opportunity to store your changes. 

NOTE 

The characteristics shown initially when the program is run and the PA 
device is selected are the default values. If you have previously 
configured the device and want to examine and change the 
characteristics, select Device > Load into PG/PC to display your 
previous values.  
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14. When you are satisfied with your choices, you can send them to the device using the menu bar 
selection Device > Load to Device.  The program will make a connection to the device at this point if 
it is not already connected.  

15. Repeat steps 10 through 12 for each device on the PA bus. 

When you are finished you can save your results and exit the program, or you can move to step 2 of the 
next subsection and begin testing your device. 

3.8 Testing a PA Device with Real-Time and Simulated Data 

A valuable feature of the PDM program is its ability to display real-time and simulated data. You can use 
these features as a quick check to determine whether the devices is working properly and can be expected 
to provide useful I/O for the a 4-mation application.  
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1. Select Start > Simatic > SIMATIC Manager. 
The program opens the most recent configuration. If you wish to see a different configuation, select it 
from the file menu. Ensure that the program is in the network view mode (View > Process Device 
Network View selected). 

2. In the right pane of the network view, select the device you wish to test and right-click it. Select Open 
Object. 

 

3. After the licensing screen appears, choose the user category Specialist. 

From this point you can read real-time data as well as force the device to output simulated values, which 
themselves can be read as if they were real-time values.  

3.8.1 Reading Real-Time Data 

Select View > Display. 
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The resulting window varies with the type of PA device selected. In the instance of a pressure transmitter, 
the following is typical. You can repeat this process with each device you wish to test.  

 

3.8.2 Simulating Data 

Depending upon the PA device, it may be possible to force it to output simulated data and status, which 
are especially useful in determining whether the 4-mation application is reading and  responding properly 
to channel data.  

Select Device > Simulation 

The resulting window varies considerably with the device under consideration. Figure 3–4 and Figure 3–5 
show the available options for a typical pressure transmitter and a typical temperature sensor. Look for a 
means of enabling and disabling the simulation and for a button or menu selection that sends the 
simulated value to the device. Sometimes such a button is labeled with a form of the verb “transfer.”  
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Figure 3–4  PDM Simulation Window for SITRANS-P 
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Figure 3–5  PDM Simulation Window for SITRANS-T3K 

3.9 Configuring 4-mation to Communicate with PROFIBUS Field I/O  

This step maps PROFIBUS I/O data to 4-mation I/O channels. This subsection focuses upon methods of 
determining and setting 4-mation softlist parameters that are unique to the PFM.  This section does not 
discuss in detail softlist parameters that are common to APACS+ I/O channels. A more expansive 
discussion of softlist parameters for the PFM is found the configuration Guide APACS+™ I/O Module 
Configuration for Version 4.40 or Higher (CG39-24, Rev 3. or higher). 

Prerequisite knowledge: 

• The  PROFIBUS configuration and the characteristics of the I/O data it communicates, including DP 
and PA PROFIBUS addresses and PROFIBUS data types. 

• Characteristics of the APACS+ system and its controller (type, memory, node-rack-slot address).  
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Prerequisite skill: the ability to create, modify, and transfer 4-mation configurations and to understand the 
implications of these actions.  

Prerequisite system: 

• DP network configured with COM PROFIBUS, and loaded into the PFM master (subsection 3.4)  

• PA devices configured with Simatic Manager PDM (subsection and 3.7) if PA devices are part of the 
network. 

1. On the engineering workstation with a MODULBUS interface, start 4-mation by selecting 
Start > Program > ProcessSuite > APACS+ > 4-mation 4.40 MBUS. 

2. Open an online or off line 4-mation configuration. The discussion to follow assumes an offline 
configuration later transferred to an online configuration. 

NOTE 

Whenever you transfer and offline configuration to an on-line PFM, the 
PFM reports an error condition that must be manually cleared before the 
PFM can communicate channel data with 4-mation. The error message is 
not cause for alarm It merely ensures that the intention to change the 
PFM configuration is understood and acknowledged. The error message 
is shown in Figure 3–6. Clear the error by clicking its description in the 
CURRENT ERRORS box. When an error is displayed you can read on-
line information about it by clicking the Detail button. 

 

Figure 3–6  Error Message When PFM Configuration Changes 
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3. When prompted, give the configuration a name and click the OK button: 

 

4. Click the Add button 

 

 A list of available hardware modules appears: 
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5. Select from the list provided the proper controller, then 
• Enter node-rack-slot information 
• Select redundancy scheme (node-to-node is not supported by PFM) 
• Assign the controller a name  
Click the OK button when you have finished. 
The 4-mation module tree opens: 
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6. Select the controller module and click the Add button at the bottom of the window: 

 

7. Add the PFM module, assigning it a proper node-slot-rack address: 
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8. Add other devices in the configuration. 

9. Double-click on the PFM in the module tree.  
The I/O Channel Table window opens: 
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10. For each PROFIBUS field I/O point  in turn, assign a channel, selecting among the available channel 
types: 

 

 You can also give the channel a name or tag identification.  

11. Click the Softlist button to open the softlist parameters window. Set the softlist parameters. (See 
Section 3.11 for details about the Softlist parameters that are unique to PROFIBUS channels). 

12. If the configuration developed thus far is satisfactory, it is prudent to ensure that it is saved off line. 
At this point you can perform some initial, cursory checks to confirm that the system is functional.  
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 With an online configuration, it is possible in 4-mation to double-click the PFM in the module tree 
and display the I/O Channel Table window. Clicking the Display Real Time Values checkbox 
produces a update of the current value of input channels as they are scanned: 

 

 Comprehensive testing of this kind requires the services of staff who are able to force field I/O to 
inject values into the channels scanned by 4-mation. Similarly, by enabling variable control on output 
channels, it may be possible to compare expected results with observed results.  

 Keep in mind that the PDM program can also force devices to output simulated values. See 
subsection 3.8.2 

3.10 Installing the COM PROFIBUS and Simatic PDM Licenses 

The Simatic PDM license is distributed on one ore more Siemens diskettes, depending upon available 
options. This disk labeled “AuthorsW” contains the SIEMENS Authorization Tool software. 
Authorization to use the PDM program, like a token, can be transferred, but not duplicated. Authorization 
can exist either on the distribution diskettes or on a hard disk drive, but not both simultaneously. It is not 
possible to copy the authorization by copying diskettes or the hard disk drive.  

To manage authorization, the program AuthorsW.exe does the following: 
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• Displays the current Simatic licensing installation on all the local disks on the workstation or laptop 
from which AuthorsW.exe has been run 

• Installs licensing from diskette to a hard disk drive 

• Returns licensing from hard disk drive to diskette 

A text file on diskette titled “Readme.txt” provides detailed instructions for using the program and 
important cautions about its licensing restrictions. These include discussion of 

• Prohibitions forbidding write-protecting diskettes. 
• Damage to the licensing authorization due to computer virus 
• Cautions against running a disk-optimizing program (defragmenter) on a hard disk drive with 

licensing installed 
• Partial backup of licensing authorizations 
• Securing emergency, temporary licensing in the event of a catastrophic failure 
• Prohibitions forbidding changing names and attributes of files and directories created by the program 

WARNING 

The authoritative source of information on topics related to licensing is 
the text file on diskette titled “Readme.txt.” Failure to heed the 
information in this file could result in data loss and an inability to run 
configuration programs.   

Having read and understood the text file on diskette titled “Readme.txt,” installation of the licensing 
authorization is straightforward.  

1. Insert the diskette containing AuthrorsW.exe authorization in your diskette drive. 

2. Run the program AuthorsW.exe 
A window opens showing the authorizations for the mass storage medium selected in the left pane. In 
the window shown below, the authorizations for the selected Drive C: are displayed. 
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3. To move an authorization from one drive to another, drag it from the right pane and drop it on the 
appropriate drive on the left pane. In the illustration above, it would be possible to remove 
authorization to run SIK/SIMATIC PDM Basis Evaluation from the selected drive (C:\) and either 
return it to the authorization diskette (A:\) or move it to another drive. 

4. When you have made desired changes, wait for drive LEDs to stop, and click File > Exit. 

3.11 PFM Softlist Parameters 

3.11.1 PFM Channel Types 

In the PFM, channel type refers to 4-mation I/O channels. PROFIBUS data type refers to data and data 
structures defined by PROFIBUS specifications. Channels in parentheses (X) are default mappings. If in 
4-mation you define a channel as an analog input, for example, the default PROFIBUS data structure is a 
DP INT16.  
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Table 3–1  Data to Channel Type Mapping 

PFM Channel Types 
 

PROFIBUS Data 
Types 

Analog 
In 

Analog
out 

BOOLEAN
In 

BOOLEAN
Out 

Packed 
Discrete 

In 

Packed 
Discrete 

Out 

PA BOOLEAN   X X   
DP BOOLEAN   X X   
DP UINT8   (X) (X) (X) (X) 
DP UINT16 X X X X X X 
DP UINT32 X X     
DP INT8 X X     
DP INT16 (X) (X)     
DP INT32 X X     
DP Float X X     
PA Float X X     

3.11.2 PFM Module Scope 

To examine the softlist parameters that apply to the entire module: 

1. In 4-mation,  open the application and display the module tree.  

2. Select the PFM module. 

3. Select Edit > Object/Item. 

4. Select PFM1 

5. Select Softlist… 
A window displays the softlist parameters for the module. 

ProfiBitRateKbps—a read-only softlist parameter that corresponds to DP baud rate and is given in kbps 
(default: 1500.0 kbps) 

The remaining parameters are reserved for future use. 
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3.11.3 PFM I/O Channel Common Softlist Parameters 

Softlist parameters enable 4-mation to translate between raw binary field I/O and three supported 
4-mation channel types: BOOLEAN, packed discrete, and analog. Softlist parameters vary according to 
the channel type. 

DP_Slave_Addr—default is 126, which must be changed to the PROFIBUS address assigned to the 
device. All the APACS+ channels mapped to a multichannel PROFIBUS device have the same 
DP_Slave_Addr.  

Byte_Offset—The Byte_Offset is the distance in bytes between the beginning of an input or output data 
block in the PFM and the first byte of the channel of interest.  

 The procedures for determining the Byte_Offset for input channels and for output channels are 
based upon similar underlying principles. For each of its DP slaves, the PFM allocates an input 
block and output block in its memory. 

 A DP device presents its inputs to the PFM in an unstructured I/O string not longer than 244 
bytes. The PFM extracts input data from the string and stores it in its input block it has allocated 
for the device. The block is uniquely identified by the DP slave address of the device that 
provides the data. The location and length of individual channel data in the block is determined 
by three softlist parameters: DP slave address of the DP device, the PROFIBUS data type, and the 
Byte_Offset. For input channels, the Byte_Offset points to the first byte of the channel’s data in 
the PFM input block for the device. For output channels, the Byte_Offset points to the first byte 
of a channel’s output data in the output block.  

NOTE 

The PFM supports input data lengths of 122 bytes (maximum) and 
output data lengths of 244 bytes (maximum) for data transfer into field 
devices. 

 Determining the byte offset so that you can set a channel’s softlist parameters requires an 
understanding of the device supplying or receiving data. 

 In the following illustration, an ET200M, a DP slave that connects with a variety of multichannel 
I/O modules, has a PROFIBUS DP address of 9. The ET200M is connected to three modules, a 4 
channel analog input module (4AI), a 4-channel analog output module (4AO), and another 4 
channel input module (4AI). The data type for the analog channels is signed 16-bit integer (each 
channel is 2 bytes long). Given the DP address of the module and the PROFIBUS data type, the 
Byte_Offset  parameter identifies the beginning of individual channel data in the PFM block. As 
this illustration shows, the PFM block for input channels is separate and distinct from the PFM 
block for output channels. Note, too, that although the input modules are not contiguous, there are 
no gaps in the input data block. 
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 ET200M  4AI  4AO  4AI

DP

0 102 4 6 8 12 14
2 Analog input modules
Signed 16 bit integers
(2 bytes each channel)

0 102 4 6 8 12 14

Byte_Offset
 

Byte_Offset
 

1 Analog output module
Signed 16 bit integers
(2 bytes each channel)

9

 

 Figure 3–7  Byte_Offset for Typical Input and Output Block 

 A DP/PA link is another common DP device that sends and receives an I/O string. In the case of 
the DP/PA link, downstream PA devices supply or receive the I/O data. 

 In the case of PA devices connected to the PFM through a DP/PA link, the PA input device with 
the lowest PROFIBUS address has its data stored in the input block of the PFM at  Byte_Offset 0. 
The next PA input device on the bus, in order of ascending PROFIBUS address, has a 
Byte_Offset equal to the bytes used by the first device.  The third input device has a Byte_Offset  
equal to the bytes used by the first two devices, and so forth. Byte_Offset for output devices is 
calculated in the same way. 

 In the illustration below, the DP/PA link device has a PROFIBUS address of 11.  The addresses 
of the PA devices (5, 7, and 8) must be unique to their PA bus, and there may be gaps. In the 
illustration, the data type of each PA device is a PA floating point structure, which consists of 4 
bytes of data and 1 byte of status per channel. The Byte_Offset for the channel associated with 
the PA address 5 is 0, the Byte_Offset of device with address 7 is 5, and the Byte_Offset of the 
device with address 8 is 10. See Figure 3–8 

5 7 8
 DP/PA

DP

PA
11

3 PA Inputs
PA floating point structures

(4 bytes data + 1 byte status)

0 5 10
Byte_Offset

 

Figure 3–8  Byte_Offset for Typical Input String 
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 Input and output data blocks in the PFM are distinct and independent of one another. The 
Byte_Offset for an input channel is thus independent of the Byte_Offset for an output channel. 

 The COM PROFIBUS program provides a useful tool for determining or confirming 
Byte_Offset: 

1. With the PROFIBUS network configured through COM PROFIBUS and  Simatic PDM, open 
COM PROFIBUS and either open the current configuration or import it from the DP master  

2. Select the DP/PA link. 

3. From the menu bar select Services > Observe/Control/Inputs/Outputs. 
The resulting display shows the current value in bytes of PA devices connected to the DP/PA 
link. You can count the bytes of input or output preceding a device of interest to determine the 
device’s Byte_Offset. Keep in mind that the data stream from a PA device includes one byte of 
status per channel. The illustration below shows data input from two PA floating point devices, 
both providing four bytes in data and one byte of status (for example, 80 hex).  

In the example, the PROFIBUS PA address of the first device is 5, so the device is located in 
position 2 (if its PROFIBUS  address were 3, the lowest permissible address for a PA device 
connected to a DP/PA link, the device would be located in position 0 ). The Byte_Offset of the 
input channel of the first device, regardless of its address,  is always 0.  

The Byte_Offset of the input channel of the next device (in position 3) is 5, which is the number 
of input bytes preceding it.  If there were a device in position 4, the Byte_Offset for its input 
channel would be 10, again determined simply by counting the preceding input bytes. See Figure 
3–9. 

 

Figure 3–9  Using COM PROFIBUS to Determine Byte_Offset 

Profibus_Slot_Number—in devices with more than one slot (module), the slot number identifies the slot 
if a PROFIBUS diagnostic message is reported. The Profibus_Slot_Number parameter has no 
effect on data I/O; it is used only for APACS error reporting. 

Profibus_Ch_Number—in devices or modules with more than one channel, the channel number 
identifies the channel if a PROFIBUS diagnostic message is reported. The Profibus_Ch_Number 
parameter has no effect on data I/O; it is used only for APACS error reporting. 
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ProfiDataType—(default in parentheses). Table 3–2 show available PROFIBUS data types and lengths 
for PFM channels. 

 

PFM Channel ProfiDataType Length 
(bytes) 

DP UINT8 1 
DP UINT16 2 
DP UINT32 4 
DP INT8 1 
DP INT16 2 
DP INT32 4 
DP Floating Point 4 

Analog input (DP INT16) 
Analog output (DP INT16) 

PA Floating Point Structure 5 
DP BOOLEAN 1 
PA BOOLEAN structure 2 
DP INT8 (as packed discrete) 1 

BOOLEAN input (DP UINT8) 
BOOLEAN output (DP UINT8) 

DP INT16 (as packed discrete) 2 
DP UNIT8 1 Packed Discrete Input (DP UINT8) 

Packed Discrete Output (DP UINT8) DP UNIT16 2 

Table 3–2  ProfiDataType SoftList Parameters 

3.11.3.1 BOOLEAN Input and Output Channels 

PA_SlaveAddr—default is 0, and the parameter is only applicable for PA devices connected to the PFM 
by a DP/PA link. The valid range is 0 through 125, corresponding to the PROFIBUS address of 
the PA device. 

PA_Status—default is 128, indicates the status for the channel for PA devices. 

BitNumber—default is 0, applicable only for BOOLEAN channel types mapped to PROFIBUS integer 
types. The bit number corresponds with the position of the data in the 8 or 16 bit data structure. 
Valid bit numbers range from 0 to 15, where 0 represents the first bit, and corresponds to labeling 
on commonly used DP discrete modules. Figure 3–10 shows how a single BOOLEAN value is 
stored in a DP UINT16 ProfiData type. 
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The value of the BOOLEAN channel
at  BitNumber 10 is 1

BitNumber

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

0 0 11 111 1 1 0 0 000 0 00

 

Figure 3–10  BitNumber in DP UINT16 Data Type 

Table 3–3  BOOLEAN Input and Output Channels SoftList Parameters 

Parameter Selection Default 

BitNumber 0-15 0 
DP_Slave_Addr 1-125 (valid range differs from default value, which must be 

changed) 
126 

Byte_Offset 0-243 0 
Profibus_Slot_Number 0-63 0 
Profibus_Ch_Number 0-63 0 
ProfiDataType DP BOOLEAN 

PA BOOLEAN Structure 
DP UINT8 
DP UINT16 
 

DP UINT8

PA_SlaveAddr  0 
PA_Status (input:read only, output: read/write 0-255) USINT 128 

3.11.3.2 Packed Discrete Input and Output Channels 

Table 3–4  Packed Discrete Input and Output SoftList Parameters 

Parameter Selection Default 

DP_Slave_Addr 1-125 (valid range differs from default value, which must be 
changed) 

126 

Byte_Offset 0-243 0 
Profibus_Slot_Number 0-63 0 
Profibus_Ch_Number 0-63 0 
ProfiDataType DP UINT8 

DP UINT16 
DP UINT8
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The byte order of I/O values differs in 4-mation, a DP slave, and COM PROFIBUS. For example, the 
bytes of a 16-bit packed discrete data type of a PROFIBUS DP slave with I/O value of 0xE65A is 
maintained as 0xE65A in 4-mation, but byte-swapped to 0x5AE6 when displayed by COM PROFIBUS.  
See Table 3–5.  

Table 3–5  Byte Order of Packed Discrete I/O Channel Data 

Software 
environment Value 

E6 5A 4-mation 

1110 0110 0101 1010

E6 5A Slave Device 

1110 0110 0101 1010

5A E6 COM PROFIBUS

0101 1010 1110 0110

Any desired changes in the positions of bits can be accommodated in 4-mation using fan-in and fan-out 
function blocks, which provide complete flexibility in encoding or decoding packed discrete data types. 
See Figure 3–11, Figure 3–12, Figure 3–13, and Figure 3–14. 
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Figure 3–11 shows a fan-out function block that takes a 16-bit packed discrete input channel as its input 
and produces 16 BOOLEAN outputs.  

 

Figure 3–11  Fan-Out to 16 Bits  
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Figure 3–12 shows a fan-in function block that converts 16 individual BOOLEAN input tags to a 16-bit 
packed discrete output channel. 

 

Figure 3–12  Fan-In from 16 Bits 
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Figure 3–13 shows a fan-out function block that takes an 8-bit packed discrete as its input and produces 8 
BOOLEAN outputs.  

 

 

Figure 3–13  Fan-Out to 8 Bits 



SD39PFM-1 Configuration 
 

 
September 2005 3-45 

Figure 3–14 shows a fan-in function block that converts 8 individual BOOLEAN input tags to an 8-bit 
packed discrete output channel. 

 

Figure 3–14  Fan-In from 8 Bits 

3.11.3.3 Analog Input and Output 

The PFM Analog input and output channel types use real (REAL) variables. The softlist parameters Bias, 
Min_Scale, Max_Scale, RawLo, and RawHi are all interrelated by equations provided in subsection 
3.11.4. 
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Table 3–6 shows the softlist parameters for the analog channel types. 

Table 3–6  Analog Input and Output SoftList Parameters 

Parameter Selection Default 

Min_Scale Any Real Number 4 
Max_Scale Any Real Number 20 
EngUnits in, ft, mm, cm, m, in3, ft3, bbl, ml, liter, m3, lb, ton, mol, g, 

kg, ft/sec, m/sec,ft/sec2, msec2, DegF, DegR, DegC, DegK, 
psi, psia, psig, InH2O, InHg, ATM, kPa, kPaa, kPag, mmHg, 
kg/cm2, mbar, bar, lb/ft3, g/cm3, kg/m3, mol/m3, ft3/lb, 
m3/kg, ppm, pH, PPH, KPPH, t/day, kg/hr, kg/day, gal/min, 
GPM, GPH, GPD, ACFM, ACFH, SCCM, SCFH, SCFM, 
MCFH, yd3/hr, yd3/day, BPD, gal/hr, gal/day, m3/hr, 
m3/day, l/min, l/hr, l/day, mV, Volts, mA, AMPS, Ohms, 
mhos, W, kW, MW, Btu, Btu/SCF, Btu/lbm, Btu/hr, hp, bhp, 
vars, VA, kVA, joules, Percent, pulses, Hz, rpm, deg, rad, 
cal, cal/SCF, cal/hr, cal/lbm, kcal, kcal/SCF, kcal/hr, 
kcal/lbm 

mA 

RawLoCounts INT -27648 
(0x9400) 

RawHiCounts INT 27648 
0x6c00) 

DigFiltTimeCnst (input 
only) 

0.0 to 159.0 sec 0.0 

Bias Any Real Number 0.0 
DP_Slave_Addr 1-125 (valid range differs from default value, which must be 

changed) 
126 

Byte_Offset 0-243 0 
Profibus_Slot_Number 0-63 0 
Profibus_Ch_Number 0-63 0 
ProfiDataType DP UINT8 

DP UINT16 
DP UINT32 
DP INT8 
DP INT16 
DP INT32 
DP Floating Point 
PA Floating Point Structure 

DP INT16 

PA_SlaveAddr  0 
PA_Status (input:read only; output:read/write, 0-255)USINT 128 

PA_SlaveAddr—default is 0, and the parameter is only applicable for PA devices connected to the PFM 
by a DP/PA link. The valid range is 0 through 125, corresponding to the PROFIBUS address of 
the PA device. 
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PA_Status—default is 128, indicates the status of the channel for PA devices. 

EngUnits:  Engineering units for the scaled value can be selected from a list of common engineering 
units. 

DigFiltTimeCnst: (Input only) Digital filtering can be applied to analog input signals to reduce 
the effects of electrical noise.  The digital filter is a first-order lag, adjustable for time 
constants of 0.0159 to 159.0 seconds (0.0 disables the filter).  Equivalent breakpoint 
frequencies are 10.0 to 0.001 Hz.  The default value can be increased for noisy signals. 

 Figure 3–15 shows the step release time of the digital filter. 

 

Step Response Time of Digital Filter

Time 
(seconds)

m
A
 

0 
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10 

15 

20 

0 1 2 3 4 5 6 7

Filter 
Input 
Filter 
Output 

Scan Rate = 100ms   T 
(DigFiltTimeCnst) = 1.0 sec. 

T 

14 (63%)

 

Figure 3–15  Step Time Response of Digital Filter 

3.11.4 Mapping Analog Channels to PROFIBUS Integer Data Types 

Bias: The user can enter a bias (in engineering units) on a per channel basis to compensate for known 
offsets.  The bias value is added to a scaled input or subtracted from a scaled output. 
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Min_Scale/ Max_Scale:  The module linearly scales raw data to engineering units for each channel.  The 
scaling algorithm (equation below) uses the Min_Scale/Max_Scale parameters set by the user.   

 For example, given a 4 to 20 mA input, a MinScale of 0.0 and a MaxScale of 100.0; if the input 
to the channel is 12 mA, the scaled value is 50.0.   

 Min_Scale and Max_Scale can be any real (REAL) number (Real numbers are valid between -
3.4028E38 and +3.4028E38.) 

RawLoCounts: specified by the user to define the value of the associated process variable. The default is 
–27648 (0x9400) when the channel value equals min scale. 

RawHiCounts: specified by the user to define the value of the associated process variable. The default is 
27648 (0x6c00) when the channel value equals max scale. 

Equations describe how analog values are mapped to integers. The result of equation (1) is used in 
equations (2) and (3). 

APACS output analog channel mapped to PROFIBUS integer analog output: 

( )
( )Min_ScaleMax_Scale

sRawLoCountsRawHiCount
unitperocountsc

−

−
=     (1) 

))((( )unitpercountsBiasvalueAnalogMax_Scalets RawHiCounalue PROFIBUS v ∗−−−=  (2) 

NOTE 

MaxScale may be less than MinScale, as might be required by a “reverse 
acting” device such as a reverse acting valve. 

APACS analog input channels mapped to PROFIBUS integer analog input: 

)(  Bias 
unitcounts per

aluePROFIBUS vsRawHiCountMax_Scale e APACS valu +⎟⎟
⎠

⎞
⎜⎜
⎝

⎛ −
−=     (3) 

3.11.5 Out of Range Errors 

Range is defined as Max_Scale – Min_Scale.  The 4-mation program sets an out-of-range error for a 
channel value that exceeds the absolute magnitude 0.05 x range (5%). A built-in hysteresis mechanism 
prevents the error from clearing until the channel value falls to the absolute magnitude of 0.03 x range 
(3%). See Figure 3–16. 
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5%

5%

3%

3%

Out of range error
Error cleared

Range = (Max_Scale - Min_Scale)

 

Figure 3–16  Out of Range Error and Hysteresis 
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Notes 
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4  Maintenance 

This section describes how to maintain the PROFIBUS Fieldbus Module (PFM) and its associated 
transition board. These items require minimal maintenance. Some routine maintenance is recommended 
in the form of a visual inspection and possible cleaning. A module’s operating status is shown by Light 
Emitting Diodes (LEDs) located on its bezel. Replacement procedures are provided for the module and its 
termination board. 

 
 

 

 
DANGER 

 

 

Explosion hazard 
 

Will cause death, serious injury or property damage 
 
• In potentially hazardous atmosphere, remove power from equipment before 

connecting or disconnecting power, signal, or other circuit, or extracting/inserting 
module. 

• Observe all pertinent regulations regarding installation in hazardous area. 
• Ensure all devices are rated for hazardous (classified) locations. 

4.1 Tool Requirements 

The following tools are necessary for servicing: 
• Common electronic servicing hand tools 
• Digital multimeter 

4.2 Visual Inspection 

The PFM and its associated assemblies should be subjected to periodic visual inspection. The frequency 
of inspection is dependent on the severity of the operating environment. 

The primary aim of the inspection is to reveal any excessive accumulation of dust, dirt, or other foreign 
material adhering to the surfaces of the termination hardware and protective covers of the module. 
Accumulation of dirt and dust prevents efficient heat dissipation and can contribute to module or system 
failure. Refer to section 3.3 for cleaning instructions. Note that a PFM module installed in a cabinet 
complying with the NEMA  (National Electrical Manufactures Association) 12/IP55 specification need 
not be inspected for cleanliness. 

4.3 Cleaning 

Cleaning the PFM involves brushing or vacuuming the protective covers to restore cooling efficiency that 
degrades by the accumulated dust, dirt, or other foreign materials. 
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Cleaning a transition board consists of careful brushing and vacuuming to remove accumulated dust and 
dirt harboring chemical particulate that can accelerate terminal or connector contact corrosion. When 
cleaning the termination hardware area, be careful not to disturb the field wiring. 

 
WARNING 

Electrical shock hazard. Remove power from all involved wires and 
terminals. 

4.4 Troubleshooting 

A module’s operating status and errors are indicated by its status LEDs. Also, error codes and related 
diagnostic messages are displayed by the 4-mation configuration software and the Diagnostic Logger 
utility. Details of error codes and messages are available in the following documents: 

• 4-mation Software Messages and Error Codes (document number CG39-21) 

• Module Diagnostic Error Codes (document number CG39-19) 

Module status and active channel LEDs are located on the module’s bezel. Note LED indications, then 
refer to Table 4–1 for PFM status and the listed documents to determine the appropriate course of action. 

 Table 4–1  OK and ACTIVE LED Indications 

LED LED INDICATION MODULE STATUS  ACTION 

OK Black (Off) 
No 24V power input to module  
 
 
Module on-board power supply failure

Troubleshoot or replace 24V power 
supply 
 
Properly seat the module 
Replace module 

OK Solid Green Module OK. Configured, with no 
faults or failures. 

Normal, no action required. 

OK Flashing Green/ Black Module not configured. No faults or 
failures. 

Download configuration 

OK Solid Red Module severe failure Replace module 

OK Flashing Red/ Green Class 2 error detected Check 4-mation error description 
(user action). 

OK Flashing Class 3 error detected Check 4-mation error description 
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(1/sec.)Red/Black (user action). 

 OK Flashing 
(5/sec.)Red/Black 

IOBUS communications error 
Check control module  
Check IOBUS cables 
Replace module 

Solid Green 1. Module in Control (calculate mode)  
ACTIVE 

Black (Off) 2. Module in verify mode (or off-line)  

A digital multimeter can be used to test I/O wiring and I/O signals to the termination assembly. Power-off 
continuity tests can be used to test for correct wiring.  

Table 4–2  RN (run) LED Indication 

 

Indication Meaning 

Solid Green Proper Profibus communications (operate mode). 
Transfer of the main part of firmware code concluded 
without error. 

Black (off) The PFM is in stop or offline mode. 
There has been a system error 
The PFM is waiting of activation of a transferred 
configuration  
 

Flashing Green(1/sec, 50% duty 
cycle) 

The PFM is in the clear mode, or 
the main part of firmware is being loaded. 
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Table 4–3  BF (Bus Fault) LED 

Indication Meaning 

Off No error, PFM is in communication with all configured 
slaves. 

On (solid red) Bus error, Possible cause: short circuit on the bus, 
differing baud rates, HSA less than master address, faulty 
RS 485 circuit. 

Flashing RED (1/sec, 50% duty 
cycle) 

Data communication is not being performed with at least 
one of the configured slaves. 

Any slave of the PFM can affect the BF LED.  Only 
slaves that are relevant to PFM I/O channels generate 
4-mation errors.  

Another way to troubleshoot the PFM is develop a test configuration using the 4-mation configuration 
software. This test configuration is to be used in an off-line service environment. A test configuration can 
be used to exercise each channel’s operation. 

To obtain spare or replacement parts, refer to Section 4.7. To return a failed assembly to the factory for 
repair, refer to subsection 2.1.4. There are no user-serviceable parts within a PFM module. 

4.5 PFM Removal/Replacement 

During operation, the PFM module communicates with its associated control module (ACM+) over the 
IOBUS. This bus runs continuously along the backplane of a module rack. A PFM can be removed from 
or installed into a rack without removing power from the module slot, from field circuits, or from the 
module rack. 

4.5.1 Removal 

1. As detailed in Figure 2–3, pull open the bezel’s pivoted top and bottom handles to expose the 
module’s slotted captive mounting screws. Loosen the screws. 

2. Grasp the top and bottom handles and pull the module from the rack. 

3. Place the module in a static shielding bag and package it for safe return. Refer to section 3.9 for return 
instructions. 
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4.5.2 Replacement 

Follow the procedure in subsection 2.2.3, “Module Installation.” 

After replacement, the PROFIBUS master configuration must be exported to the new PFM using COM 
PROFIBUS. 

4.6 Transition Board Removal/Replacement 

4.6.1 Removal 

Refer to the mechanical details of Figure 2–3. 

1. As necessary, take appropriate steps to shutdown the processes monitored or controlled by the field 
devices connected transition board. 

2. Remove the associated PFM from its slot in the rack. Place the module in a static shielded bag for 
protection. 

3. Disconnect PROFIBUS DP cable from the DB-9 connector. 

4. As shown in Figure 2–2, use a screwdriver to loosen the transition board from its local termination 
panel. 

4.6.2 Replacement 

Follow the procedure in subsection 2.2.1 

4.7 Spare and Replacement Parts 

One spare PFM should be stocked for every 10 in service. Spare and replacement assemblies can be 
ordered from one of the addresses in the Warranty statement and the end of this manual or through a local 
Siemens representative. Assembly part numbers are listed in Section 5 and printed on most modules. 

When ordering, provide the model number from the module’s nameplate to be replaced or spared. A 
purchase order number should also be included. 

There are no user-serviceable parts within PFM module. See Section 6 for descriptions of spare and 
replacement parts 

4.8 Maintenance Records 

An accurate record keeping system for tracking maintenance operations should be established and kept up 
to date. Data extracted from the record can serve as a base for ordering maintenance supplies, including 
spare parts. The record can also be useful as a troubleshooting tool. In addition, maintenance records may 
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be required to provide documentary information in association with a service contract. It is suggested that 
the following information be recorded: 

• Date of service incident 
• Name or initials of service person 
• Brief description of incident symptoms and repairs performed 
• Replacement part or assembly number 
• Software compatibility code of original part 
• Software code of replacement part 
• Serial number of original part 
• Serial number of replacement part 
• Issue number of original circuit module 
• Issue number of replacement circuit module  
• Displayed error codes/channel states from module LEDs, user interface, and configuration software 
• Date of completion 
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5  Circuit Description 
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Figure 5–1  PFM Block Diagram 
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6  Parts and Accessories 

6.1 Hardware 

Table 6–1  PFM and Transition Board Part Numbers 

Item Part Number Model Number 

PFM Module 16440-21 39PFMAAN

Not used
Hardware compatibility code

Firmware compatibility code  

 

PFM Transition Board 16439-1  

Table 6–2  PC PROFIBUS Products 

Product Description Siemens Part Number Purpose 

CP5611 PCI CARD 
F/PROFIBUS 

6GK15611AA00 Installed in a PC 
running COM 
PROFIBUS and PDM 
allowing direct 
communication to the 
DP and PA buses.  

CP5511 PCMCIA CARD 
F/PROFIBUS 

6GK15511AA00 Installed in a notebook 
PC running COM 
PROFIBUS and PDM 
allowing direct 
communication to the 
DP and PA buses. 
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Table 6–3  DP/PA Link 

Product Description Siemens Part Number Purpose 

PS 307 Power Supply – 2A 6ES73071BA000AA0 24 VDC power supply for 
a DP/PA link or a coupler

DP/PA Link 6ES71570AA810XA0 Allows integration of a 
PA bus with the DP bus 
without restricting DP 
communication speed. 

DP/PA COUPLER NON-EX-
VERSION 

6ES71570AC800XA0 Allows integration of a 
PA bus with the DP bus 
(non explosion proof 
version) 

DP/PA COUPLER EX-
VERSION 

6ES71570AD000XA0  Allows integration of a 
PA bus with the DP bus 
(explosion proof version)

DIN rail – 482 mm 6ES73901AE800AA0 To install DP/PA link or 
coupler 
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Table 6–4  PROFIBUS Connectors 

Product Description Siemens Part Number Purpose 

PROFIBUS DP 
FastConnect Bus 
Connector (180°, 12Mbit/s) 

6GK15000FC00 DP bus connector with 
switchable terminator 

Connector RS 485 (axial) 6GK15000EA02 DP bus connector with 
switchable terminator 

DP Bus connector Fast 
Connect (90°) 

6ES79720BA500XA0 DP bus connector with 
switchable terminator 

DP Bus connector Fast 
Connect (90°) w/ additional 
9 pin Sub-D    

6ES79720BB500XA0 DP bus connector with 
switchable terminator 

DP Bus connector (90°) 
(screw terminals)    

6ES79720BA110XA0 DP bus connector with 
switchable terminator 

DP Bus connector (90°) 
(screw terminals) w/ 
additional 9 pin Sub-D    

6ES79720BB110XA0 DP bus connector with 
switchable terminator 

DP Bus connector (35°) 
(screw terminals)    

6ES79720BA400XA0 DP bus connector with 
switchable terminator 

DP Bus connector (35°) 
(screw terminals) w/ 
additional 9 pin Sub-D 

6ES79720BB400XA0 DP bus connector with 
switchable terminator 
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Table 6–5  Field Devices 

Product Description Siemens Part Number Purpose 

BT200 DP-Test device   6ES71810AA010AA0 Handheld PROFIBUS 
communication 
troubleshooting tool. 

BT200 TESTING 
CONNECTOR 

6EP81060AC20  

BT200 NC BATTERY 6EP81060HA01  

BT200 TEST CABLE 6EP81060HC01  

BT200 CHARGER 110VAC 
(V2) 

6ES71938LB000AA0  

BT200 PROTOCOL KIT 
95/98/NT 

6ES71938MA000AA0  

RESISTOR RS485 6ES79720DA000AA0  

BUS TERMINAL 12M 
W/1,5M CABLE 

6GK15000AA10  

S7 RE485 
REPEATER,CONN.PRO/MP
I 

6ES79720AA010XA0  

SpliTConnect Tap, 
create PROFIBUS-PA 
segments & connecting PA 
field devices 

6GK19050AA00 PA bus connection 

SpliTConnect M12 Outlet, 
PA field devices to 
SpliTConnect Tap via M12 
connection 

6GK19050AB00 PA bus connection 
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Table 6-5  Field Devices (continued) 

SpliTConnect Coupler, 
coupling element cascades 
SpliTConnect Taps to create 
star points 

6GK19050AC00 PA bus connection 

SpliTConnect Terminator (Ex: 
flameproof)  

6GK19050AD00 PA bus connection 

SpliTConnect Terminator 
(non-flameproof) 

6GK19050AE00 PA bus connection 

Table 6–6  Cable and Accessories 

Product Description Siemens Part Number Purpose 

100 m PROFIBUS LAN 
Cable 

6XV18300EH10  

PROFIBUS PA Process 
Cable Blue (IS area) 

6XV18305EH10 PA cable for 
Intrinsically Safe area 

PROFIBUS PA Process 
Cable Black (Non-IS area)  

6XV18305FH10 PA cable for Non-
Intrinsically Safe area 

FastConnect Stripping Tool 6GK19056AA00 Wire stripping tool for 
PROFIBUS cables 

Spare blade cassettes for 
FastConnect Stripping Tool 

6GK19056AB00 Blades for wire 
stripping tool 
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6.2 Software 

COM PROFIBUS V5.1  (Part Number PS02-2324V3.02) is used to configure master and slave 
addresses and bus parameters for PROFIBUS DP networks.  This software is delivered with the PFM and 
does not have to be ordered separately as a line item. 

PDM V5.1 + SP2  This software is needed to parameterize PROFIBUS  DP/PA and/or any HART 
devices that are connected to the PFM via a linking device or remote I/O module.  A control system that 
does not have any DP/PA or HART devices (connected to the PFM via ET-200M) does not need this 
software.    Customers will have to purchase appropriate licenses (floppies) in order to be able to use 
PDM.  A customer will need to order item 1 and one or more of the options listed in Table 6–7 below. 



SD39PFM-1 Parts and Accessories 
 

 
September 2005 6-7 

Table 6–7  SIMATIC PDM V5.1 +SP2 

 

Option Description Order  Number 

PDM Starter package V5.1 + SP2 FOR PCS 7 
SIMATIC PDM Basic Software. Integration in STEP7/PCS 7, routing, 
PROFIBUS-DP/PA communication option. Maximum of 128 tags. 

6ES7658-3PX01-0YC0 

PDM V5.1 + SP2 Basic Package 
Basic software for operation and parameterization of process devices 
and components including communication via HART-modem, 
including RS232, Maximum of 16 tags. 6ES7658-3AX01-0YC0

PDM Maintenance Contract 
Basic software for operation and parameterization of process devices 
and components including communication via HART-modem, 
inlcuing RS232. Maximum of 16 tags.  6ES7658-3XX00-0XX0

PDM V5.1 + SP2 Options for Expansion of Basic Package 

Integration in STEP7/PSC 7  6ES7658-3BX00-2XD0

Routing via S7-400 6ES7658-3CX00-2XD0

Communications via PROFIBUS-SP-PA 6ES7658-3DX00-2XD0

Communications via Standard HART Multiplexer 6ES7658-3EX00-2XD0 

Runtime Diagnostics 6ES7658-3FX00-2XD0 

Tag Options for Simatic PDM V5.1 + SP2 

Up to 128 Tags 6ES7658-3XA00-2XD0

Up to 512 Tags 6ES7658-3XB00-2XD0

Up to 1024 Tags 6ES7658-3XC00-2XD0

Up to 2048 Tags 6ES7658-3XD00-2XD0

Up to 4096 Tags 6ES7658-3XE00-2XD0 

Up to 8192 Tags 6ES7658-3XF00-2XD0 

Up to 16284 Tags 6ES7658-3XG00-2XD0
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7  Specifications 

7.1 PFM Module Specifications 

Table 7–1  PFM Module and I/O Specifications 

Type Specification Data 

Module Module Weight 3.5 lbs. (1.6 kg) 

 Module’s Input Voltage 24VDC +/- 10% 

 Maximum Supply Input 
Current 

0.3 A 

 Supply Inrush Current 2.5 A 

 Dielectric Strength Tested with 860 Vdc for 2 second between Profibus (DB9) 
Connector and chassis 

 Heat Dissipation 
(typical) 

8 W. 

 Operating temperature 0° to 60°C (32° to 140°F) 

 Storage Temperature -25° to 85°C (-13° to 185° F) 

 Operating Humidity  5 to 95% non-condensing 

 Storage Humidity 0 to 100%, condensing 

 Corrosives Class GX 

Inputs/Outputs Profibus DP 9.6 Kbps to 12 Mbps 

 Number of channels 210 max. 

 Channel types supported AI/AO, DI/DO, Packed DI/DO 

 Module Scan Time  100 ms 

 Redundancy Support APACS+ module non-redundant and peer to peer 
redundant ACM configuration 

 Agency Approvals See module nameplate 
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7.2 Electrical Classification 

7.2.1 Approvals 

Table 7–2  Agency Approvals for the PFM 

Agency Standard Level Description 

UL UL 508  N/A Industrial Control Equipment 

CSA C22.2 No. 0, 0.4,142, 213 Class I, Div. 2, 
Groups A,B,C,D 

CLASS 2258 02 - PROCESS CONTROL EQUIPMENT – for 
Class I, Division 2, Group A, B, C and D Hazardous Locations 

FM Class 3611 Class I, Div. 2, 
Groups A,B,C,D 

Safety standard for electrical and electronic test, measuring, 
controlling and related equipment for use in Class I, Div. 2 
hazardous locations. 

CE Mark EN 50081-2:1993 
 
 
 
EN 61000-6-2:1999 

N/A 
 
 
 
 
N/A 

Electromagnetic compatibility - Generic emission standard -Part 
2: Industrial environment 
 
Electromagnetic compatibility (EMC) - Part 6-2: Generic 
standards - Immunity for industrial environments 

PNO PROFIBUS Certification per 
EN 50170 (DIN 19245 part 3) 

N/A Interoperability and functional testing as a standard PROFIBUS 
DP Class1 Master 

 

7.2.2 CSA Hazardous Locations Precautions 

This section provides CSA hazardous location precautions that should be observed by the user when 
installing or servicing the equipment described in this Instruction.  These statements supplement those 
given in the preceding section. 

 
 

 

 
DANGER 

 

 

Explosion hazard 
 

Will cause death, serious injury or property damage 
 
• In potentially hazardous atmosphere, remove power from equipment before 

connecting or disconnecting power, signal, or other circuit, or extracting/inserting 
module. 

• Observe all pertinent regulations regarding installation in hazardous area. 
• Ensure all devices are rated for hazardous (classified) locations. 
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Precautions—English 

For Class I, Division 1 and Class I, Division 2 hazardous locations: 

• Use only factory-authorized replacement parts. Substitution of components can impair the suitability 
of this equipment for hazardous locations. 

For Division 2 hazardous locations: 

When the equipment described in this Instruction in installed without safety barriers, the following 
precautions should be observed. Switch off electrical power at its source (in non-hazardous location) 
before connecting or disconnecting power, signal, or other wiring. 

Précautions—Français 

Emplacements dangereux de classe I, division 1 et classe I, division 2: 

• Les pièces de rechange doivent être autorisées par l'usine. Les substitutions peuvent rendre cet 
appareil impropre à l'utilisation dans les emplacements dangereux. 

Emplacement dangereux de division 2: 

Lorsque l'appareil décrit dans la notice ci-jointe est installé sans barrières de sécurité, on doit couper 
l'alimentation électrique a la source (hors de l'emplacement dangereux) avant d'effectuer les opérations 
suivantes branchment ou débranchement d'un circuit de puissance, de signalisation ou autre. 

7.2.3 Special Conditions for Safe Use 

• Use of the equipment in a manner not specified by the manufacturer may impair the protection 
provided by the equipment. 

• Install the equipment in a metal enclosure. 

• Route electrical power to the equipment through a clearly labeled circuit breaker or on-off switch that 
is located near the station and is accessible by the operator. The breaker or switch should be located in 
a non-explosive atmosphere unless suitable for use in an explosive atmosphere. 

• I/O and I/O wiring must be shielded. 

• The last page of this document contains a Declaration of Conformity with the standards or other 
normative documents stated on the certificate. 

• Environmental Conditions, Per IEC 664, Installation Category III, Pollution Degree 2 

• A representative unit was tested in accordance with EN50082-2. Test results are available upon 
request. 
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